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Microsemi makes no warranty, representation, or guarantee regarding the information contained
herein or the suitability of its products and services for any particular purpose, nor does
Microsemi assume any liability whatsoever arising out of the application or use of any product or
circuit. The products sold hereunder and any other products sold by Microsemi have been
subject to limited testing and should not be used in conjunction with mission-critical equipment
or applications. Any performance specifications are believed to be reliable but are not verified,
and Buyer must conduct and complete all performance and other testing of the products, alone
and together with, or installed in, any end-products. Buyer shall not rely on any data and
performance specifications or parameters provided by Microsemi. It is the Buyer's responsibility
to independently determine suitability of any products and to test and verify the same. The
information provided by Microsemi hereunder is provided “as is, where is” and with all faults,
and the entire risk associated with such information is entirely with the Buyer. Microsemi does
not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other IP rights,
whether with regard to such information itself or anything described by such information.
Information provided in this document is proprietary to Microsemi, and Microsemi reserves the
right to make any changes to the information in this document or to any products and services
at any time without notice.

About Microsemi

Microsemi Corporation (NASDAQ: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for aerospace & defense, communications, data center and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world's standard for time; voice
processing devices; RF solutions; discrete components; enterprise storage and communication
solutions; security technologies and scalable anti-tamper products; Ethernet solutions; Power-
over-Ethernet ICs and midspans; as well as custom design capabilities and services. Microsemi
is headquartered in Aliso Viejo, California, and has approximately 4,800 employees globally.
Learn more at www.microsemi.com.
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Introduction to FlashPro Express

About FlashPro Express

FlashPro Express is Microsemi's programming tool designed from the ground up to address secured
programming assurance in production programming house environments. FlashPro Express supports
SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3, Fusion, and ProASICPLUS devices in the
Windows OS environments and supports SmartFusion2, IGLOO2, and RTG4 in the Linux OS environments.

You can install FlashPro Express two ways:

e Integrated with Libero - FlashPro Express is installed automatically when Libero is installed. FlashPro
express is used by Libero to perform the programming tasks for SmartFusion2, IGLOO2, and RTG4, as part
of the design flow.

e Stand-Alone - FlashPro Express is also available as a standalone installation. This mode is primarily used
for production programming or lab programming on machines in which a full version of Libero is not
required. When installed using the stand alone installation, FlashPro Express is joined by the predecessor
product FlashPro.

See the Microsemi Website for more information on FlashPro and FlashPro Express.

Secure Job Programming

Job programming is the concept of using a single file to program a Microsemi device or chain of Microsemi
devices using encrypted bitstreams.

The single job file contains all of the information necessary to setup FlashPro Express as well as the encrypted
bitstream images for the devices in the job. Once a job file is created it can be handed off securely to production
programming houses or contract engineering facilities to load the Microsemi images during manufacturing. Job
projects can be exported from Libero and imported into stand-alone FlashPro Express providing a clean
delineation between design flow and production programming.

Migrating FlashPro Projects to FlashPro Express

Existing FlashPro projects (*.pro) files are now called Job Project files in FlashPro Express. These Job Projects
can be opened with FlashPro Express to take advantage of Linux programming support and the simplified tool
targeted for operators in a production floor environment.
FlashPro projects that were created in single mode will not be supported with this tool. Microsemi recommends
that you convert these projects to chain mode projects. To convert the project to a chain project, do the following
steps:

1. Open the FlashPro project (*.pro) in FlashPro.

2. Locate the loaded STAPL file by one of two methods:

The log will print “STAPL file ‘<stapl_path>" has been loaded successfully.” <stapl_path> is the location of
the STAPL file loaded.

fils 'D:\:-_-s:_p:e;e::\p:c;e:::a:a'\:cpderaul:.s-.p' has besn loaded successfuolly.

i : vop; CHECKSUM : F673; ALG VERSION : 2

s ) Wormngs | Info [

Within the Single Device Configuration Window there is a field STAPL_FILE_NAME, which displays
the location of the STAPL file loaded.
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Single Device Configuration Window

Programming file

topdefault.stp ? | Browse...
Modify. ..
DATE MODIFIED Wed Oct 29 15:-20:-Z5 2014 -~

STAPL_FILE HNAME
CEEATOR
DEVICE
DACEACE

DATE
STAPL_VERSION
IDCODE

IDMASE

DESIGH
MHECESTT

1|

D:-\teat projecthyprojectData'topdefault._at
FlashPro Version: wll._.4

MZ5050T

MZ5050T-£g484

2014/06/18

JESD71

OF8021CF

OFFFFFFF

top
FET3

m

I I

Chain Parameter...

Inspect Device

3. Switch the project to chain mode by one of the two methods:
a. Press the chain button from the toolbar.

| %

b. From the Tools menu, select Mode->Chain Programming.

4. Load the STAPL file in chain mode by adding a Microsemi device in the chain.

a. From the File menu, select Configuration->Add Microsemi Devices from Files.
b. Browse to the location of the STAPL file and click Open.

5. To save the project, from the File menu, select Save Project.

6. You may now open the project using FlashPro Express.

When moving FlashPro project (*.pro) files to another machine, Microsemi recommends that you archive the
entire project folder, copy it to the new machine, extract it locally, then load the job project within FlashPro
Express. FlashPro Express will only open a job project if a programmer is connected to the machine, at least one
Microsemi device has programmed enabled, and all enabled Microsemi devices have a bitstream file loaded.

Supported Families - FlashPro Express

The table below lists the device families and their derivatives that FlashPro Express can program directly through
Libero or by exporting a FlashPro Express job:

Table 1 - Product Families and Derivatives Directly Supported by FlashPro Express

Device Family Family Description
Derivatives
SmartFusion2 N/A Address fundamental requirements for advanced security, high
reliability and low power in critical industrial, military, aviation,
communications and medical applications.
IGLOO2 N/A Low-power mixed-signal programmable solution
RTG4 N/A Radiation-tolerant programmable solution



https://www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2
https://www.microsemi.com/products/fpga-soc/fpga/igloo2-fpga
https://www.microsemi.com/products/fpga-soc/radtolerant-fpgas/rtg4
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In addition, FlashPro Express supports the programming of all the following Microsemi devices in a JTAG chain
by one of the following methods:

e A FlashPro Project that was migrated to a FlashPro Express Project .

OR

e A FlashPro Express Project for one of the primary devices (above) that includes other devices in the JTAG

chain from the list of devices below.

Table 2 - Product Families and Derivatives Supported in the JTAG chain

Device Family Family Description
Derivatives

SmartFusion N/A SmartFusion intelligent mixed-signal FPGAs are the only devices that
integrate an FPGA, ARM Cortex-M3, and programmable analog,
offering full customization and IP protection.

Fusion N/A Mixed-signal FPGA integrating ProASIC3 FPGA fabric,
programmable analog block, support for ARM® Cortex™-M1 soft
processors, and flash memory into a monolithic device.

IGLOO IGLOO The ultra-low-power, programmable solution

IGLOOe Higher density IGLOO FPGAs with six PLLs and additional I/O
standards
IGLOO nano The industry’s lowest power, smallest size solution
IGLOO PLUS The low-power FPGA with enhanced 1/O capabilities
ProASIC3 ProASIC3 The low-power, low-cost, FPGA solution
ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and additional 1/O

standards

ProASIC3 nano

Lowest cost solution with enhanced I/O capabilities

ProASIC3/EL

ProASIC3L The FPGA that balances low power, performance, and low cost
Automotive ProASIC3 FPGAs qualified for automotive applications
ProASIC3

Military Military temperature A3PE600L, A3P1000, and A3PE3000L

RT ProASIC3

Radiation-tolerant RT3PE600L and RT3PE3000L

N/A

ProASIC PLUS Supported by FlashPro Express ONLY- not supported by Libero SoC.

Installing FlashPro Express Software and Hardware

See the Microsemi Website for more information about FlashPro Express.
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https://www.microsemi.com/products/fpga-soc/fpga/proasic3-overview
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Getting Started

Starting FlashPro Express

Start FlashPro Express by running the program at [installation folder] > bin > FPExpress.

FlashPro Express Interface

The main FlashPro Express Ul consists of a list of programmers and a chain table, as shown in the figure below.
This view displays the programmers connected to the machine, and the devices within the JTAG chain specified
in the job project file (PRO) file, as shown in the figure below.

e Hover over the programmer Info icon to display more information about a programmer.

e Click the Name field to change a programmer name.

e Click the checkbox to enable or disable a programmer.

¢ Right-click a programmer to Ping, Self-Test, Scan, Check Chain or Remove it from the list.

e Additional information about a device and programming file, if loaded, can be viewed by hovering over the
info icon of that device.

e Devices specified as disabled in the job project (*.pro) file are shown disabled and their HighZ value is
displayed in the column header.

e Device/Programmer States:
e |IDLE: The devices/programmers are idle and not executing any programming action.
e DISABLED: Devices that are not enabled for programming
e PASSED: The last programming operation passed
e FAILED: The last programming operation failed
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Figure 1 - FlashPro Express Programmers and Chain Table

Creating a Job Project from a FlashPro Express Job

Once you are ready to hand off your design for production you can create a job project. To do so:

1. InLibero run Export FlashPro Express Job to create a container that will be used to transfer programming
configuration information, including programming files, to the production programming tool FlashPro

Express.
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Export FlashPro Express Job

FlashPro Express Job file

Name: rammer
Location: [/soft/sqatest14/southard/lib proj/proj v11 8fram pf22/designer/rammer/export | [ ... |

Existing files:
<MNo FlashPro Express |ob files found=>
Zeroization actions
Like New (Erases all user data; device can be immediately reprogrammed by user)
Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

Selected Security options (Configure Security tool)
Encrypt bitstream with default key. No user keys or security settings are enabled.

Design bitstream file to be included in the programming job
Bitstream components

File to program at trusted facility ¥| Fabric SHNVM

Configured device chain with bitstream files and programmer settings will be included in the programming job.

CEZIR 23

Figure 2 - Export FlashPro Express Job
2. In FlashPro Express, from the Project menu choose New Job Project From FlashPro Express Job. You
will be prompted to specify the Programming Job File location that you just exported from Libero and the
location of where to store the FlashPro Express Job Project. The Job Project name automatically uses the
programming job name and cannot be changed. Click OK and a new Job Project will be created and opened
for production programming.

New Job Project from FlashPro Express Job

Programming job file:

fsoft/sqatest9/southard/proj_v1l_8/s 4/designer/sort_4/export/sort_4.job

FlashPro Express job project name:

ﬂ sort_4

FlashPro Express job project location:

fsoft/sqatest9/southard/proj_wvll_8/s 4/fpx

P |

(=

Figure 3 - New Job Project from FlashPro Express Job Dialog Box

Load a Job Project

To get started in FlashPro Express you must load a job project (*.pro file). To do so, from the Project menu
choose Open Job Project. A job project will open if:

e Atleast 1 programmer is connected
e Atleast 1 Microsemi device is enabled for programming
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e Any enabled Microsemi device for programming must have a bitstream file loaded

Note: FlashPro projects (*.pro) created in single chain mode are not supported with this tool. You must
create a chain mode project with the existing programming files within FlashPro prior to using
FlashPro Express.

To open a project:
1. From the Project menu, choose Open Job Project. The Open Project dialog box appears.

2. Find your project file or type in your project file name in the File name field.
3. Click Open.

(5 FlashPro Express E=x Ech = |
Project  Edit View Progremmer  Help

Job Projects
Lreate..:
Open...
Recent Projects

Log =R

,i""eﬂ'ﬂ“ €3 Erors i, Wamings i Info

Figure 4 - FlashPro Express Launch Screen

Saving a Job Project

Click the Save button on the toolbar, or from the Project menu choose Save Job Project to save your project.

Programming Tutorials

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple programmers.
In parallel programming, all targeted devices are programmed with the same programming file (STAPL). The
targeted device or chain configuration that is connected to each programmer must be identical.

The FlashPro Express software together with the FlashPro5/4/3/3X programmers supports parallel programming
via a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a USB v2.0 port.
FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device programming
time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

Note: FlashPro (USB/LPT1) or FlashPro Lite programmers do not support parallel programming.

10
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The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel programming.

>| FlashPro3 ProAsICE
H FlashPro3 ProASIC3I/E
u

g p—r

> FlashPro3 '—b-ProASI[yE
H
4 FlashPro3 ProAsIC3/E

B ————»

AN
l

>

Figure 5 - Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming
works best with the vendor's latest driver installed and with the matching hubs.

Chain Programming Tutorial

This tutorial demonstrates how to use FlashPro Express to program a multi-device, multi-programmer chain. This
tutorial uses the production programming flow that exports a programming job from Libero SoC, which includes
chain configuration, programmer settings, and bitstream files for programming, and creates a job project from a
programming job.

The figure below shows the chain used in this tutorial. M2S050T is device 1 and A3P250 is device 3. Device 1 is
the first device to be programmed in the chain and device 2 is the last; device 3 is disabled and will not be
programmed.

E FlashPro Express  CAlNFPepress_Tutonal\FPexpress_projectitest/test.pro

Progect  Edit  View Programrer  Help

i\ReFresh.l'Rescan Programmers |
(3 ] mezsosoT awrE1son A3P2S0
Programimer
STpo0  TOIS GTpo TG G TDO Highz OFF TDI O
1 (@ o IDLE IDLE IDLE DISABLED
z W smere ILE IDLE IDLE DISABLED

Figure 6 - Chain Programming Devices
To program a chain:

1. From the Project menu, choose New Job Project from FlashPro Express Job.

2. Click Browse to load a Programming Job File, and specify your FlashPro Express job project location.
Click OK to continue, as shown in the figure below.

11
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New Job Project from FlashPro Express Job

Programming job file:

/soft/sqatest9/southard/proj_v1l_8/s 4/designer/sort_4/export/sort_4.job

FlashPro Express job project name:

6 sort_4

FlashPro Express job project location:

Jsoftfsqatest9/southard/proj_v11l_8/s 4/fpx

Qo] P |
Figure 7 - New Job Project from FlashPro Express Job

FlashPro Express displays your Job Project and programmers, as shown in the figure below. The
Device/Programmer states are:

e |IDLE: The devices/programmers are idle and not executing any programming action
e DISABLED: Devices that are not enabled for programming

e PASSED: The last programming operation passed

e FAILED: The last programming operation failed

[Z2 FlashPro Express CAlj\FPexpress_Tutorlal\FPexpress_projectitestitest,pro == E08 @
Project  Edit  View Prograrnmer  Help
| Refresh/Rescan Programmers I
(i ] mzsosor @ awEisco @ A3P250
Programmer
< TDO ™I 2 < TDO DI 3 < TDO HighZ Off TDI O
1 @@ osis2 IDLE IDLE IDLE DISABLED
2 o vl 09592 IDLE IDLE IDLE DISABLED
[PROGRAM |
Log & X
ijMessages QErrcrs 4, Wamings 0Infu
Software Version: 11.4.0.101 =
STAPL file 'C:\1lij\FPexpress_Tutorial\FPexpress project\test\M25050T tesc M25050T.stp' has been loaded
succeasfully.
DESIGN : test; CHECKSUM : 3R67; ALG _VERSION : 2 -

Figure 8 - FlashPro Express with Loaded Job Project
See the Export Programming Job topic for information on how to generate a Programming Job file.

3. Click the Refresh/Rescan button if your programmer is not listed. Hover your mouse over the Info icon to
view device info. If a device is Disabled for programming the HighZ status appears in the GUI, as shown in
the figure above.

4. Set the Programming Action in the dropdown menu to PROGRAM, as shown in the figure below.

12
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|PROGRAM -

| DEVICE_INFO
|ENC_DATA_AUTHENTICATION
| ERASE

|READ_IDCODE
VERIFY

Figure 9 - Programming Action Set to PROGRAM

5. Click RUN. Detailed individual programmer and device status information appears in the Programmer List.

Your programmer status (PASSED or FAILED) appears in the Programmer Status Bar, as shown in the
figure below.

e Hover over the Programmer Status Bar to display information on the programmers.
e Hover over the FAILED status to list all programmers that failed programming.
e Hover over the PASSED status to list all the programmers that programmed successfully.

[Z2 FlashPro Express Cij\FPexpress_TutoriaNFPexpress_projectitestitest.pro fol-e-)=
Project  Edit  Wiew Programmer Help

| M25050T AZPE1500 AP250

orogrammer i ] o o
@TpO DI GTDO OIS &ITDO HighZOff TDIG

D 0v we IS RSN S o

: O o= (I ey (e (| p———
[DEV[(.E _INFO

Log & x
@Ermrs /A, Warnings i Info

O R O Sy S

Chain Programming Flnlahed Mon Jun 09 10: 02 13 2014 (Elapsed time 00:00:00) o

oc-g=-g0=-0=-0=20 F|

Figure 10 - Chain Programming Complete
View the Log for Messages, Errors, Warnings and Info generated during programming.

13
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Programmer Settings and Operations

Introduction

The FlashPro Express software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove and
analyze the JTAG chain, as shown in the figure below.

EE FlashPro Express Z:\QTFP_testing\pc_pro_FP\m2s050_896fbga_fab\m2s050_896fbga_fab.pro

Project Edt View Programmer Help
Refresh/Rescan Programmers
(] MZs0saT
Programnmes
& TDO oI
1 ([ OE | IELE . e
L i Pig
Self Test
Scan and check chain
Remaove
Enable/Disable
PROGRAM -
Log B x
(E) Messages | @ Erors  f), Wamings L) Info
STAPL file ‘Z:\(QTFP_teating\pc_pro_FP\u2s050_5%6fbga_fab\projectData\sdl.stp' has been loaded successfully. ~
DESIGN : sdl; CHECKSUM : 9EDF; ALG_VERSION : 2
Driver : 3.0.0 build 1
programmer ‘87272' : FlashProd
Opened 'I:/QTFP_tesving/pc_pro_FP/m2s050_8S96fbga_fab/m2s050_§96fbga_fab.pro' w

Figure 11 - FlashPro Express Right-Click Menu

Programmer Settings

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and FlashPro.

Note: You can set the TCK setting in the PDB/STAPL file by selecting the TCK frequency in the
Programmer Settings dialog box.

Limitation of the TCK frequency for the selected programmer:
e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro5: 1, 2, 3, 4, 5, 6, 10, 15, 30 MHz
e FlashPro4:1, 2, 3,4,5,6 MHz
e FlashPro3/3X: 1, 2, 3, 4, 6 MHz
Limitation of the TCK frequency for the target device:
e IGLOO, ProASIC3, and Fusion — 10MHz to 20MHz
e ProASICPLUS and ProASIC — 10 MHz.
e SmartFusion2, IGLOO2, and RTG4 - 30MHz

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file will override the TCK
frequency setting selected by you in the Programmer Settings dialog box unless the Force TCK Frequency
checkbox is selected.
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FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see figure above). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.

Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro Express
programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.

e The Drive TRST option is unchecked to instruct the FlashPro Express programmer(s) NOT to drive the
TRST pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro Express to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made your
selection(s), click OK.

Default Settings

e The Vpp and Vpn options are checked to instruct the FlashPro Express Lite programmer(s) to supply Vpp
and Vpn.

e The Drive TRST option is unchecked to instruct the FlashPro Express Lite programmer(s) NOT to drive the
TRST pin.

e The Force TCK Frequency option is unchecked to instruct the FlashPro Express Lite to use the TCK
frequency specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings
For FlashPro5/4/3/3X, you have the option of choosing the Set Vpump setting or the Force TCK Frequency. If you
choose the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings, you have
the option of switching the TCK mode between Free running clock and Discrete clocking. After you have made
your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the

device.
NOTE: VPUMP voltage will not be checked for the SmartFusion2/IGLOO2 and newer families of devices.
VPUMP does not need to be connected to the programmer for these devices.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK frequency
specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting), the selected TCK value is set for the
programmer and the Frequency statement in the PDB/STAPL file is ignored.

Default TCK frequency
When the IPD/STAPL file or Chain does not exist, the default TCK frequency is set to 4AMHz. When more than
one Microsemi flash device is targeted in the chain, the FlashPro Express software passes through all of the files
and searches for the "freq" keyword and the "MAX_FREQ" Note field. The FlashPro Express software uses the
lesser value of all the TCK frequency settings and the "MAX_FREQ" Note field values.
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Ping Programmers

Right-click a programmer and choose Ping.
Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

Right-click the programmer you want to self-test and choose Self Test.

Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

Note: Self-test is not supported with FlashPro5/4 or FlashPro Lite programmers. These programmers are
rigorously tested at the factory during production.

Scanning and Checking a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have selected
and checks that chain scanned matches the chain configured in FlashPro Express.

To scan a chain:

Right-click the programmer you want to scan and choose Scan and check chain.

Enabling and Disabling Programmers

After loading a job project, you can enable/disable or remove a programmer and can also ping, self-test, run scan
and check chain on any of the connected programmers. These actions are available in the shortcut menu (right-
click) for each of the programmers listed in the programmer column.

Click the checkbox next to a programmer in the Programmer column to enable or disable it. The programmer is
enabled when there is a tick mark in the checkbox and disabled when the checkbox is empty.

Renaming a Programmer

Enter the new programmer name in the Programmer window to rename the programmer. By default, the
programmer name is the same as the programmer ID.

Removing a Programmer

Right-click the programmer and choose Remove.

Selecting and Running an Action

FlashPro Express supports the following programming actions:
e DEVICE_INFO

e ENC_DATA_AUTHENTICATION
This action is only visible if every device in the chain contains encrypted bitstream files. Selecting this action
causes each bitstream file to be checked for authentication.

e ERASE

¢ PROGRAM

e READ_IDCODE
e VERIFY

To select a programming action:

Select an action from the Programming Action dropdown menu in FlashPro Express, as shown in the figure
below.

16



& Microsemi

FlashPro Express User Guide Power Matters.

-
| DEVICE_INFO
ENC_DATA_AUTHENTICATION

| ERASE

i READ_IDCODE
VERIFY ;

Figure 12 - FlashPro Express Programming Actions

To run the selected programming action:
Click on the RUN button below the Programming Action dropdown menu.
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Chain Programming

Chain Order

Chain Programming enables you to program several devices at one time. The order of devices in the chain
imported from Job Project must match the physical chain to be programmed.

The TDO for the first device connects to the programmer, and the last device's TDI connects to the programmer.
The devices in the chain go in order from a device's TDI into the next device's TDO, as shown in the figure below.

(55 FlashPro Express Ciiran\chainddevicesichainddevices.pro = [ B .
Project  Edit  View  Programmer  Heip

Refreshjfisscan Pragrammers.

(i} 43750 a MZ50507 [ ] MZSI507

Frogrammer

= TDO ™ 2 - TDO b B= 7 ToO ™ 3

[ : JEIR T IDLE HLE ILE IELE
: @F s DIE E LE LE
3 OF e BLE AR IOLE IOLE
4+ @E ssa IDLE HLE HLE ILE
s @ E s DLE L Ll L
: @E sun E HLE 13 IDLE
7 @WN esses DLE HLE OLE ILE
s @F osws IE ELE HLE LE
s @W s DIE HAE AE LE
1w @F sas IDLE IOLE IDLE IDLE il
{pROGRAM -

RUN IDLE
g 5 x

[El=as] @ o 4 Wamngs @10
programmer '87140' : FlashProd
prograamer '83956' : FlashProd
prograamer 'G FlashProd
prograaner ' : FlashPro4
prograamer ' t FlashProd
progreaner ' FlashProd
prograamer ' FlashProd
programmer ' FlashProd
prograaner B FlashProd
prograsmer '86746' : FlashProd

Opened 'C:/kiran/chainidevices/chainidevices.pro’
Project asved.

Figure 13 - Chain Order

Multiple Device Chain Programming

The FlashPro Express software enables direct chain programming without generating a chain STAPL file. Each
device will be programmed in sequential order starting from device 1 to device N. See example below. For more
information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

Device Programming Compatibility

SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3, Fusion families can be programmed in the
same chain.
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Programmer Support

FlashPro5/4/3/3X supports the SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3, Fusion family
devices. The Vpump on FlashPro5/4/3/3X is designed to support the programming of only one device. Please
make sure that Vpump, Vcc and Vjtag are provided on board for chain programming. Connect the Vpump to the
header as the Flashpro Express software will attempt to check for all external supplies, including Vpump, to
ensure successful programming. There is no limitation to the chain length; however, ensure that the JTAG signal
integrity and the timing are preserved.
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TCL Commands - FlashPro Express

About TCL Commands - FlashPro Express Tcl Command

Reference

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from the
Windows command line or store and run a series of Tcl commands in a *.tcl batch file. The Tcl commands
supported by FlashPro Express are listed in the table below.

Note: Tcl commands are case sensitive. However, their arguments are not.

Command

Action

close_project

Closes the FlashPro project

configure flashpro prg

Changes FlashPro programmer settings

configure flashpro3 prg

Changes FlashPro3 programmer settings

configure flashpro4 prg

Changes FlashPro 4 programmer settings

configure flashpro5 prg

Changes FlashPro 5 programmer settings

configure flashprolLite prg

Changes FlashPro Lite programmer settings

create_job

Create a job in FlashPro Express

dump_tcl_support

Unloads the list of supported FlashPro Tcl commands

enable serialization

Enables or disables serialization programming.

open_project Opens a FlashPro project
ing_pr Pings one or more programmers

refresh_prg_list

Refreshes the programmer list

remove_pr

Removes the programmer from the programmer list

run_selected actions

Runs the selected action on the specified programmer and returns the exit code from the

action

save_log

Saves the log file

save_project

Saves the FlashPro project

scan_chain_prg

Runs scan chain on a programmer

select serial range

Selects the range of indexes to program.

self_test prg Runs Self-Test on a programmer
set_prg_name Changes the user name of a programmer
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Command

Action

set_programming_action Selects the action for a device

set_serialization lo

g_file Sets the path and name of the serialization log file.

Running Tcl Scripts from within FlashPro Express

Instead

of running scripts from the command line, you can use FlashPro Express's Execute Script dialog box to

run a script.

To execute a Tcl script file within FlashPro Express:

1. From the File menu, choose Execute Script to display the Run Script dialog box.
-

E Run Script M
ScriptFile: |
Arguments:

[
(] [con
b
Figure 14 - Run Script Dialog Box

2. Click the Browse button to display the Open dialog box, in which you can navigate to the folder containing
the script file to open. When you click Open, FlashPro Express enters the full path and script filename into
the Run Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a space
character. For information about accessing arguments passed to a Tcl script, see Running Tcl Scripts From
the Command Line.

4. Click Run.

Running Tcl Scripts from the Command Line

You can run Tcl scripts from your Windows or Linux command line.

To execute a Tcl script file in the FlashPro Express software from a shell command line:

1. At

the prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon, and then

the name of the script file as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>

The example below executes in batch mode the script foo.tcl:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl

The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl logfile:foo.txt

The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:
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2.

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console _mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide' FlashPro Express executes without a console
window. If you want to leave the console window open you can run the script with the console_mode
parameter set to 'show', as in the following example:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:show
logfile:foo.txt

If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"

variable as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename> SCRIPT_ARGS:"paraml
param2 param3'

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:
puts "Script name: $argv0"
puts “Number of arguments: $argc"
set i1 0
foreach arg $argv {
puts "Arg $i : $arg"”
incr i
¥
Note: Script names can contain spaces if the script name is protected with double quotes:
FPExpress script:"FPExpress tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro Express

To export a set of Tcl commands from the FlashPro Express history:

1.
2.

4.

From the File menu, choose Export Script File.
Enter the filename and click Save. The Export Script Options dialog appears (as shown in the figure below).

@ Export Script @Iﬂ

Script file:  pxported. td -
Files name formatting

@ Relative file names (relative to the script file location)

Qualified file names (full path; induding directory name)

riep o J[ concel |

Figure 15 - Script Export Options Dialog Box

Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames(absolute path, including the directory name).

Click OK.
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Tcl Commands Supported by FlashPro Express

close_project
Closes the FlashPro or FlashPro Express project.

close_project

Arguments

None

Supported Families

All

Exceptions

None

Example

close_project

complete_prog_job

Tcl command; completes the current open job and generates a Job Status container including cryptographically
signed Job Ticket end certifiers and Certificates of Conformance (if enabled) of the programmed devices. It
archives ticket data from the HSM database. The resultant Job Status container can be imported into Job
Manager and validated using U-HSM. If the job status file is not specified, the information is printed in the log
window, and no Job Status container is created for subsequent verification.

The HSM Job can only be completed if the number of devices in each HSM ticket has been exhausted. If devices
remain, the job can only be terminated by using the “-terminate” option.

complete _prog_job [-job_status file path]\
[-terminate]

NOTE: This command will fail if there are devices left in any HSM ticket and the terminate option is not used.

Arguments

[-Job_status_file path]

Full path to the output Job Status container which contains End-Job Certifier and CofCs. If not specified,
information will be printed in the log window.

[-terminate]

This option will terminate the HSM job even if there are devices left in any HSM ticket. This parameter is
optional if the number of devices in all tickets have been exhausted.

Supported Families

SmartFusion2, IGLOO2

See Also:
SPPS User Guide
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User HSM Installation Guide
Manufacturer HSM Installation Guide
Job Manager User Guide

configure_flashpro_prg

Changes FlashPro programmer settings.

configure_flashpro_prg [-vpp {ONJOFF}] [-vpn {ON]|OFF}] [-vddl {ON]OFF}] [-force_vddp
{ON|OFF}] [-vddp {2.-5]3-3}] [-drive_trst {ON]JOFF}] [-force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpp {ON]OFF}

Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON|OFF}

Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-vddl {ON]JOFF}

Enables FlashPro programmer to drive VDDL; set to ON to drive VDDL.
-force_vddp {ON|OFF}

Enables FlashPro programmer to drive VDDP; set to ON to drive VDDP.
-vddp {2.5]3.3}

Sets VDDP to 2.5 or 3.3 volts.

-drive_trst {ON]|OFF}

Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.
-freq {freq}

Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

ProASICELYS ProASIC

None

The following example enables the FlashPro programmer to drive the VPP, VPN, VDDL, VDDP, sets the
drive voltage to 3.3v, disables the driver for TRST, and does not force the programmer to use the TCK
frequency specified in the software.

configure_flashpro_prg —vpp {ON} —vpn {ON} —vddl {ON} —force_vddp {ON} —vddp {3.3} —
drive_trst {OFF} —force_freq {OFF}

configure_flashpro3_prg
Changes FlashPro3 programmer settings.
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configure_flashpro3 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON]|OFF}] [-freq {freq}]

Arguments

-vpump {ON]OFF}

Enables FlashPro programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]free_running_clk}

Specifies free running or discrete TCK.

-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

SmartFusion, IGLOO, ProASIC3 and Fusion

None

The following example sets the VPUMP option to ON, TCK to free running, and uses the TCK frequency specified
in the programmer file (force_freq is set to OFF):

configure_flashpro3_prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{4}

The following example sets VPUMP to ON, TCK to discrete, forces the FlashPro software to use the TCK
frequency specified in the software (-force_freq is set to ON) at a frequency of 2 MHz.

configure_flashpro3 _prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro4 prg

Changes FlashPro4 programmer settings.

configure_flashpro4_prg [-vpump {ON]JOFF}] [-clk_mode {discrete_clk]free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpump {ON]OFF}

Enables FlashPro4 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]free_running_clk}

Specifies free running or discrete TCK.

-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.
-freq {freq}

Specifies the TCK frequency in MHz.
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Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions

None

Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro4_prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{4}

The following example sets the VPUMP option to ON, uses a discrete TCK and sets force_freq to ON at 2 MHz.
configure_flashpro4_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro5_prg
Tcl command; changes FlashPro5 programmer settings.

configure_flashpro5_prg [-vpump {ON]JOFF}] [-clk_mode {free_running_clk}]
[-force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpump {ON]OFF}

Enables FlashPro5 programmer to drive VPUMP. Set to ON to drive VPUMP. Default is ON.
-clk_mode {free_running_clk}

Specifies free running TCK. Default is free_running_clk.

-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file. Default is OFF.

-freq {freq}
Specifies the TCK frequency in MHz. Default is 4.

Supported Families
SmartFusion2, IGLOO2
Exceptions

None
Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).
configure_flashpro5_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets the VPUMP option to ON, uses a free running TCK and sets force_freq to ON at 2
MHz.
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configure_flashpro5_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {ON} -freq
{2}

configure_flashproLite prg
Changes FlashPro Lite programmer settings.

configure_flashproLite_prg [-vpp {ONJOFF}] [-vpn {ON|OFF}] [-drive_trst {ON|OFF}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpp {ON]OFF}

Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON|OFF}

Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-drive_trst {ON]|OFF}

Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

ProASICELUS

Exceptions

None
Example

The following example sets the programmer to drive the VPP, drive VPN, drive the TRST and uses the
frequency set by the programmer file (sets force_freq to OFF):

configure_flashprolite_prg —vpp {ON} —vpn {ON} —drive_trst {ON} —force_freq {OFF}

create_job_project
Tcl command; creates a Flashpro Express job using the programming job exported from Libero.

create_job_project —job_project_location location —job_file path —overwrite 0|1

Arguments

-job_project_location location

Specifies the location for your FlashPro Express job project.

-job_file path

Path to the Libero job file that is used as input to create the Flashpro Express job project.
-overwrite 0|1
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Set value to 1 to overwrite your existing job project. .

Supported Families

SmartFusion2, IGLOO2, RTG4

Exceptions

None

Example

The following example creates a job project named test.job in the \fpexpress directory. It does not
overwrite the existing job project.

create_job_project \
-job_project_location {D:\fpexpress} \
-job_Tfile {D:\test\designer\test\export\test.job} —overwrite O\

dump_tcl_support
Unloads the list of supported FlashPro or FlashPro Express Tcl commands.

dump_tcl_support -file {file}
Arguments
-file {file}
Supported Families

All

Exceptions

None
Example

The following example dumps your Tcl commands into the file 'tcldump.tcl'
dump_tcl_support -file {tcldump.tcl}

enable_serialization
This Tcl command enables or disables serialization programming.

enable_serialization —name {device_name} -enable {true|false}

Arguments
-name
Specifies the device name.
-enable

Enables (true) or disables (false) serialization programming.
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Exceptions

Must be a Microsemi Device

Supported Families

Fusion, ProASIC3, IGLOO, SmartFusion, SmartFusion2, IGLOO2

Example

enable_serialization -name M2S/M2GLO50{T|S|TS} -enable true

get_job_status
Tcl command; exports status of current open job. The job status contains number of devices left for each HSM
ticket. If job status file is not specified, the information is printed in the log window.

get_job_status [—job_status_file path] \
[-archive]

Arguments

[-job_status_file path]
Path to the output FlashPro Express job status container. The job status file can be sent to the Job
Manager application and Certificates of Conformance (if available) validated using the U-HSM.

[-archive]

Moves the HSM ticket log files from the HSM ticket database to the HSM ticket archive. The archive folder
was specified during HSM installation and setup.

NOTE: If no job_status_file is specified, the archive option prints the Certificates of Conformance in the
log window without exporting them.

Supported Families

SmartFusion2, IGLOO2

See Also

SPPS User Guide

Manufacturer HSM Installation Guide
User HSM Installation Guide

Job Manager User Guide

open_project
Opens a FlashPro or FlashPro Express project.

open_project -project {project}

Arguments

-project {project}
Specifies the location and name of the project you wish to open.
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Supported Families

All
Exceptions
None
Example
Opens the 'FPPrjl.pro' project from the FPProjectl directory
open_project -project {./FPProjectl/FPPrjl._pro}
ping_prg

Pings one or more programmers.
ping_prg (-name {name})*
Arguments

-name {name}
Specifies the programmer to be pinged. Repeat this argument for multiple programmers.

Supported Families

All

Exceptions

None

Example

The following example pings the programmers 'FP300085' and 'FP30086'.
ping_prg —name {FP300085} —name {FP300086}

process_job_request

Tcl command; processes a job request received from Job Manager. It is part of the Job Ticket generation
process.

NOTEL: This command does not require a FlashPro Express project to be created or opened.
NOTE2: HSM parameters must be configured using set_hsm_params before processing job request.
process_job_request —request_file path \

-reply_file path \
[-overwrite_reply {TRUE | FALSE}]

Arguments

—request_file path
Full file name of job request file.
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-reply_file path

Full file name of job reply file.

-overwrite_reply {TRUE | FALSE}

TRUE allows overwriting of any pre-existing reply_file.

Supported Families

SmartFusion2 and IGLOO2

Example

process_job_request \
-request_Tfile {D:/flashpro_files/jobmgr_projectl2/cm_request.req} \
-reply_file {D:/flashpro_files/jobmgr_projectl2/cm_reply.rep} \
-overwrite_reply {TRUE}

See Also
SPPS User Guide
Job Manager User Guide

set_hsm_params

refresh_prg_list

Refreshes the programmer list. This is most often used to have FlashPro or FlashPro Express detect a
programmer that you have just connected.

refresh_prg_list
Arguments

None

Supported Families

All

Exceptions

None

Example

refresh_prg_list

remove_hsm_tickets
Tcl command; removes HSM tickets from the HSM using one of the following methods:
e By specifying the job reply file in which case all tickets that are in the reply file will be deleted.
e By specifying each of the ticket IDs value in hexadecimal string.
remove_hsm_tickets [-reply_file path] \
[-ticket_ids ticketID+] \
[-all]
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Arguments
-reply_file path

Full file name of job request file.
-ticket_ids ticketlD+

Hex value of each ticket ID to be removed.

Supported Families

SmartFusion2, IGLOO2

Example
remove_hsm_tickets \

-reply_file {D:flashpro_filesjobmgr_projectl2cm_reply.rep}
remove_hsm_tickets \

-ticket_ids {00000000000000000000899f252d9fb55442aa7e
00000000000000000000b6¥385c6a9eecab9705¢c
00000000000000000000ed5702d0b767ba686b82}

NOTES
e This command should be used very carefully since it removes HSM tickets, rendering any FlashPro Express
jobs based on those tickets to be unusable.
e This command does not require a FlashPro Express project to be created or opened.
See Also
SPPS User Guide
Job Manager User Guide
remove_prg

Removes the programmer from the programmer list.

remove_prg (-name {name})*

Arguments

-name {name}*
Specifies the programmer to be removed. You can repeat this argument for multiple programmers.

Supported Families
Al
Exceptions
None
Example

The following example removes the programmer '03178' from the programmer list:
remove_prg (name {03178})*
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run_selected_actions

Runs the selected action on the specified programmer and returns the exit code from the action. If no
programmer name is specified, the action is run on all connected programmers. Only one exit code is
returned, so return code cannot be used when action is run on more than one programmer. A
programming file must be loaded.

run_selected_actions [(-name {name})*]

Arguments

-name {name}

Optional argument that specifies the programmer name. You can repeat this argument for multiple
programmers.

Supported Families

Exceptions

Example

save_log

All

None

The following example runs the selected actionS on the programmers 'FP30085' and 'FP30086'".
run_selected_actions —name {FP300085} —name {FP300086}
Example using return code:

if {[catch {run_selected_actions} return_val]} {puts "Error running Action"} else {puts
"exit code $return_val"}

Example returning exit code to the command line (returns exit 99 on script failure, otherwise returns exit
code from selected action):

if {[catch {run_selected_actions} return_val]}{exit 99} else {exit $return_val}

Saves the log file.

save_log -file {file}

Arguments

—file {File}
Specifies the log filename.

Supported Families

Exceptions

All

None
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Example

The following example saves the log file with the name 'my_logfilel.log":
save_log -file {my_logfilel.log}

save_project
Saves the FlashPro or FlashPro Express project.

save_project

Arguments

None
Supported Families

All
Exceptions

None

Example

save_project

scan_chain_prg
In single mode, this command runs scan chain on a programmer.

In chain mode, this command runs scan and check chain on a programmer if devices have been added in
the grid.

scan_chain_prg [(-name {name})+]

Arguments

-name {name}
Specifies the programmer name.

Supported Families
Al
Exceptions
None
Example

The following example runs scan chain on a single programmer (single mode) named '21428":
scan_chain_prg -name {21428}
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select_serial_range
This Tcl command selects the range of indexes to program.

select_serial_range -name device_name -from_data start_index_to_program -to_data
end_index_to_program

Arguments

-name
Specifies the device name.
-from_data

Specifies the start index to program.

-to_data

Specifies the end index.
Supported Families

Fusion, ProASIC3, IGLOO, SmartFusion, SmartFusion2, IGLOO2
Exceptions

Must be a Microsemi Device

Example

select_serial_range -name M2S/M2GLOSO{T|S|TS} -from data 3 -to_data 5

self test prg
Runs Self-Test on a programmer.

self_test_prg (-name {name})*

Arguments

-name {name}
Specifies the programmer name. You can repeat this argument for multiple programmers.

Supported Families
Al
Exceptions
None
Example

The following examples runs the self test on the programmer '30175"
self_test_prg (-name {30175})*
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set_hsm_params

Tcl command; saves the HSM parameters for the FlashPro Express application. These parameters remain in
effect until overridden by another invocation of this command.

set_hsm _params —hsm_server_name hsm_server \
-hsm_type_u {TRUE|FALSE} \
-m_hsm_uuid m_uuid \
-ftp_username ftp_username \
-ftp_password ftp_password

NOTEL: The HSM parameters are persistent between multiple FlashPro Express sessions on the same
computer.

NOTE2: HSM parameters only need to be set for HSM flow jobs.

Arguments

-hsm_server hsm_server

Name or IP address of HSM server computer
-hsm_type_u {TRUE|FALSE}

TRUE FlashPro Express will use the Manufacturer features of the User HSM.
FALSE FlashPro Express will use a Manufacturer HSM.
-m_hsm_uuid m_uuid

UUID of HSM to be used for FlashPro Express tasks.
-ftp_username ftp_username

User name to access the HSM files via FTP server.
-ftp_password ftp_password

Password to access the HSM files via FTP server.

Supported Families
SmartFusion2 and IGLOO2

Example

set_hsm_params -hsm_server_name {10.241.140.224} \
-hsm_type_u {0} \
-m_hsm_uuid {0000000000000000000000000000000000000002F} \
-ftp_username {hsm} \
-ftp_password {hsm}

set_prg_name
Changes the user name of a programmer.

set_prg_name -name {name} -new_name {new_name}

Arguments

-name {name}

Identifies the old programmer name.
-new_name {new_name}

Specifies the new programmer name.
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Supported Families

All devices supported by FlashPro.

Exceptions

None

Example

The following example changes the name of the programmer 'FP300086' to 'FP3Prg2":
set_prg_name —name {FP300086} —new_name {FP3Prg2}

set_programming_action

Selects the action for a device. The device name parameter must be specified only in chain programming
mode. A programming file must be loaded. The device must be a Microsemidevice.

set_programming_action [-name {name}] -action {action}
Arguments

-name {name}

Specifies the device name.
-action {action}
Specifies the action.

Supported Families

SmartFusion, IGLOO, ProASIC3, Fusion, SmartFusion2, IGLOO2, RTG4
Exceptions

Must be a Microsemi device
Example

The following example sets the programming action in single programming mode:
set_programming_action —action {PROGRAM}

And in chain programming mode:
set_programming_action —name {MyDevicel} —action {ERASE}

set_programming_file

Sets the programming file for a device. Either the file orthe no_file flag must be specified. A
programming file must be loaded. The device must be a Microsemi device .

set_programming_Ffile [-name {name}] [-Ffile {file}] [-no_Ffile { }]

Arguments

-name {name}
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Specifies the device name. This argument must be specified only in chain programming mode.
—file {File}

Specifies the programming file.

-no_File

Specifies to unload the current programming file.

Supported Families

SmartFusion, IGLOO, ProASIC3, Fusion, SmartFusion2, IGLOO2, RTG4
Exceptions

Must be a Microsemi device.
Examples

In single programming mode:

set_programming_file —file {e:/design/pdb/TopA3P250.pdb}

In chain programming mode:
set_programming_file —name {MyDevice2} —File {e:/design/pdb/TopA3P250.pdb}
set_programming_file —name {MyDevicel} —no_Tfile

set_serialization_log_file
This Tcl command sets the path and name of the serialization log file.

set_serialization_log_file -file {log file path}

Arguments

-File
Specifies the serialization log file path and name

Supported Families
Fusion, ProASIC3, IGLOO, SmartFusion, SmartFusion2, IGLOO2
Exceptions
Must be a Microsemi Device

Example

set_serialization_log_file -file {C:/local_z_folder/work/my_serial_log}
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Troubleshooting

Exit Codes (SmartFusion2 and IGLOQO2)

Error
Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

0

Passed (no error)

0x8002

5

Failure to configure
device programming at
1.2/1.0 VCC voltage

Unstable voltage level

Signal integrity issues on
JTAG pins

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8032

Device is busy

Unstable VDDIx voltage level

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

0x8003

Failed to enter
programming mode

Unstable voltage level

Signal integrity issues on
JTAG pins

DEVRST_N is tied to LOW

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

Tie DEVRST_N to HIGH prior to
programming the device.

0x8004

Failed to verify IDCODE

Incorrect programming file
Incorrect device in chain

Signal integrity issues on
JTAG pins

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for
reflection. If TRST is left floating then add
pull-up to pin.

Reduce the length of Ground connection.

0x8005
0x8006
8x804A

10

Failed to program eNVM

Unstable voltage level.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
Signal integrity issues on specifications. See your device datasheet
JTAG pins. for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8027 10 Authentication Error Libero device selection does | Generate a programming file with the
0x8028 not match the target device. correct device selection for the target
Bitstream and device device.
mismatch
0x8007 11 Failed to verify FPGA Device is programmed with a | Verify the device is programmed with the
0x804C Array different design or the correct data/design.
component is blank.
Failed to verify Fabric Monitor related power supplies that cause
Configuration Unstable voltage level. the issue during programming; check for
transients outside of Microsemi
Failed to verify Security | Signal integrity issues on specifications. See your device datasheet
JTAG pins. for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8008 11 Failed to verify eNVM Device is programmed with a | Verify the device is programmed with the
0x8009 different design. correct data/design.
0x8049
Unstable voltage level. Monitor related power supplies that cause
the issue during programming; check for
Signal integrity issues on transients outside of Microsemi
JTAG pins. specifications. See your device datasheet
for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8013 -18 Digest request from Digest request from SPI/JTAG | Provide a programming file with a pass
SPI/JTAG is protected by [ is protected by user pass key | key that matches pass key programmed
User Pass Key 1 1. Lock bit has been into the device.
configured in the Debug Policy
within SPM (Security Policy
Manager)
0x8014 -19 Failed to verify digest >Unstable voltage level Monitor related power supplies that cause

Signal integrity issues on
JTAG pins

the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8015 -20 FPGA Fabric digest Programming bitstream Use the same programming file that was
verification: FAIL components do not match used to program the device.
components programmed
FPGA Fabiric is either erased
or the data has been
corrupted or tampered with
0x8016 -20 eNVM_0 digest Programming bitstream Use the same programming file that was
verification: FAIL components do not match used to program the device.
components programmed
eNVM_0 data has been
corrupted or tampered with
0x8017 -20 eNVM_1 digest Programming bitstream Use the same programming file that was
verification: FAIL components do not match used to program the device.
components programmed
eNVM_1 data has been
corrupted or tampered with
0x8018 -20 User security policies Programming bitstream Use the same programming file that was
segment digest components do not match used to program the device.
verification: FAIL components programmed
User security policy segment
data has been corrupted or
tampered with
0x8019 -20 User key set 1 segment | Programming bitstream Use the same programming file that was
digest verification: FAIL [ components do not match used to program the device.
components programmed
User key set 1 segment data
has been corrupted or
tampered with
0x801A -20 User key set 2 segment | Programming bitstream Use the same programming file that was
digest verification: FAIL [ components do not match used to program the device.
components programmed
User key set 2 segment data
has been corrupted or
tampered with
0x801B -20 Factory row and factory | Programming bitstream Use the same programming file that was

key segment digest
verification: FAIL

components do not match
components programmed

Factory row and factory key

used to program the device.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
segment data has been
corrupted or tampered with
0x801C -20 Fabric configuration Programming bitstream Use the same programming file that was
segment digest components do not match used to program the device.
verification: FAIL components programmed.
Fabric configuration segment
data has been corrupted or
tampered with
0x801D |-21 Device security The device is protected with
0x801E prevented operation user pass key 1 and the
0x804B bitstream file does not contain | Run DEVICE_INFO to view security
user pass key 1. features that are protected.
User pass key 1 in the Provide a bitstream file with a user pass
bitstream file does not match | key 1 that matches the user pass key 1
the device. programmed into the device.
0x801F -22 Authentication Error eNVM has been locked by a Release the lock on the eNVM after your
0x8020 master in your design master has completed its access
0x8040 Bitstream or data is operations. Write 0x00 to "REQACCESS"
corrupted or noisy Running VERIFY action on a | register in eNVM Control Registers
blank device. (address 0x600801FC) to release the
access.
Bitstream file has been
corrupted Program the device prior to running
VERIFY action
Bitstream was incorrectly
generated Regenerate bitstream file.
0x8021 -23 Authentication Error File contains an encrypted key | Provide a programming file with an
0x8022 that does not match the encryption key that matches that on the
Invalid/Corrupted device device.
encryption key
Attempting to erase a device | Run DEVICE_INFO action to verify that
with no security using master | the device has no security. If the device
security file does not have secuirty, you cannot erase
it.
File contains user encryption
key, but device has not been | First program security with master
programmed with the user programming file, then program with user
encryption key encryption 1/2 field update programming
files.
Device has user encryption
key 1/2 enforced and you are | You must first ERASE security with the
attempting to reprogram master security file, then you can
security settings reprogram new security settings.
0x8041 -23 Authentication Error File contains an encrypted key | Provide a programming file with an
that does not match the encryption key that matches that on the
Invalid/Corrupted device device.
encryption key
File contains user encryption | Run DEVICE_INFO action to verify that
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
key, but device has not been | the device has no security. If the device
programmed with the user does not have secuirty, you cannot erase
encryption key it.
Attempting to erase a device | First program security with master
with no security using master | programming file, then program with user
security file encryption 1/2 field update programming
files.
Device has user encryption
key 1/2 enforced and you are | You must first ERASE security with the
attempting to reprogram master security file, then you can
security settings reprogram new security settings.
0x8023 -24 Authentication Error Design version is not higher Generate a programming file with a design
0x8024 than the back-level version higher than the back level version.
0x8042 Back level not satisfied programmed device
0x8001 -24 Failure to read DSN Device is in System Controller | TRSTB should be driven High or disable
Suspend Mode "System Controller Suspend Mode".
Check board connections
0x8025 -25 Authentication Error DSN specified in programming | Use the correct programming file with a
0x8026 file does not match the device | DSN that matches the DSN of the target
0x8043 DSN binding mismatch being programmed device being programmed.
-26 Authentication Error Device does not support the Generate a programming file with the
0x8044 capabilities specified in correct capabilities for the target device.
Insufficient device programming file
capabilities
0x8027 -26 Authentication Error Libero device selection does | Generate a programming file with the
0x8028 not match the target device correct device selection for the target
Bitstream and device device.
mismatch
0x8029 -27 Authentication Error Incorrect programming file Choose the correct programming file and
0x802A select the correct device in chain.
0x8045 Incorrect DEVICEID Incorrect device in chain

Measure JTAG pins and noise or

Signal integrity issues on reflection. If TRST is left floating, then add
JTAG pins pull-up to pin.

Reduce the length of ground connection.
0x802B -28 Authentication Error Programming file version is Generate programming file with latest
0x802C out of date version of Libero SoC.

Programming file is out
of date, please
regenerate
0x8046 -28 >Authentication Error Old programming file Generate programming file with latest
version of Libero SoC.
Unsupported bitstream
protocol version
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x802F -30 JTAG interface is Invalid or no UPK1 is provided | User needs to provide correct UPK1 to
protected by UPK1 unlock device.
0x8030 -31 Authentication Error M2S090 Rev. A or M2S150 User can program a valid application
0x8031 Rev. A: code. This can be done with SoftConsole.
0x8048 Invalid or inaccessible
Device Certificate Either certificate is corrupted FAB_RESET_N should be tied to HIGH.
or the user hasn't provided the
application code in the eNVM
or provided invalid application
code
FAB_RESET N is tied to
ground
0x8032 -32 Instruction timed out Unstable voltage level Monitor related power supplies that cause
0x8033 the issue during programming; check for
0x8034 Signal integrity issues on transients outside of Microsemi
0x8035 JTAG pins specifications. See your device datasheet
0x8036 for more information on transient
0x8037 specifications.
0x8038
0x8039 Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8010 -35 Failed to unlock User Pass key in file does not Provide a programming file with a pass
Pass Key 1 match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x8011 -35 Failed to unlock User Pass key in file does not Provide a programming file with a pass
Pass Key 2 match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x8012 -35 Failed to unlock debug Pass key in file does not Provide a programming file with a pass
pass key match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x804D -36 <HSM related error HSM communication error. Check if HSM the communication path to
message based on HSM call returns error. HSM is up. Make sure project is loaded
scenario> properly and that HSM tickets have not
been cleaned.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x804E -37 Device already has HSM flow does not support Erase security and try programming the

Security programmed. device.
Please erase the device
using master file before

reprogramming Security

reprogramming device directly
if Security has already been
programmed.

Settings.

Exit Codes for Software v8.6 and Above (SmartFusion, IGLOO,
ProASIC3 and Fusion)

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in software v8.6 and
ABOVE only. See the Device Exit Codes for pre-v8.6 Software help topic for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 3 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in Software v8.6 and Above

Error Code Exit Exit Message Possible Cause Possible Solution
Code
0 Passed (no error)
1 A physical chain Physical chain
does not match the configuration has
expected set up from | been altered.
the STAPL file. Something has
Also known as become
Checking Chain disconnected in the
Error. chain.
The specific IR
length of non-
Microsemi devices
may be incorrect.
The order of the
specified chain may
be incorrect.
0x8052 5 Failed to enter Unstable VPUMP Monitor related power supplies that cause the
programming mode. | voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Signal integrity
issues on JTAG Monitor VITAG during programming; measure
pins. JTAG signals for noise or reflection.
Device is in Disble the FlashFreeze pin (ProASICL or
FlashFreeze mode IGLOO devices)
(ProASICL or IGLOO
devices) Generate STAPL file with the latest version of
Designer/FlashPro.
Older software or Use latest version of FlashPro software.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
programming file
used.
0x801D 6 Failed to verify Incorrect Choose the correct programming file and select
0x8053 IDCODE programming file the correct device in chain.
Incorrect device in Measure JTAG pins and noise or reflection. If
chain TRST is left floating then add pull-up to pin.
Signal integrity Reduce the length of ground connection.
issues on JTAG pins
0x8005 6 Failed to verify AES | Programming file Generate STAPL file with the latest version of
0x8009 Sec. generated with an Designer/FlashPro. Use latest version of
0x800B older version of FlashPro software.
software
Try again at a slower TCK.
Contact Microsemi Technical Support.
0x8008 6 Failed to verify File is not for M7, but | Check that the target device is M7 enabled.
IDCODE. target device is M7
Make sure that the programming file you
Target is an M7 Signal integrity generated is for an M7-enabled device.
device issues on JTAG
pins. Measure JTAG pins, noise and reflection.
0x800A 6 Failed to verify Files not for M1, but | Check that the target device is M1 enabled.
IDCODE target device is M1.
Make sure the programming file generated is for
Target is an M1 Signal integrity an M1-enabled device.
device issues on JTAG pins
Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
0x800C 6 Failed to verify File is not for target | Check the target device; make sure the
IDCODE. device. programming file generated is matches the
target device.
Core enabled device | Signal integrity
detected issues on JTAG pins | Monitor VJTAG during programming; measure
JTAG signals for noise or reflection.
0x800D 6 Failed to verify File is for M7 but Check that the target device is not M7 enabled.
IDCODE. target device is not
M7. Make sure that the programming file generated
The target is not M7 is for non-M7 enabled device.
device Signal integrity
issues on JTAG Monitor VITAG during programming; measure
pins. JTAG signals for noise or reflection.
0x800E 6 Failed to verify File is for M1, but Check that the target device is not M1 enabled.

IDCODE.

Target is not an M1
device

target device is not
M1.

Make sure that the generated programming file
is for non-M1 enabled device.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
Signal integrity Monitor VIJTAG during programming; measure
issues on JTAG pins | JTAG signals for noise or reflection.
0x8006 6 Failed to verify File is not for P1, but | Check that the target device is P1 enabled.
IDCODE. target device is a P1
device. Make sure programming file generated is for M1
Target is nota P1 enabled device.
device Signal integrity
issues on JTAG pins | Monitor VJTAG during programming; measure
JTAG signals for noise or reflection.
0x801E 6 A3PE600 Contact Microsemi Technical Support
Engineering Sample
Device Detected.
This device is
supported with pre-
v8.3 SP1 STAPL files
only
0x8057 8 Failed Erase Unstable VPUMP Monitor related power supplies that cause the
Operation. voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8058 10 Failed to program Monitor related power supplies that cause the

FPGA array at row
<row number>.

Unstable VPUMP
voltage level.

Unstable VCC

Unstable VCC_OSC
(Fusion only)

Unstable
VCC_ROSC voltage
level (SmartFusion

only)

Signal integrity
issues on JTAG
pins.

issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
0x805D 10 Failed to enable Unstable VPUMP Monitor related power supplies that cause the
0x805E FPGA Array. voltage level. issue during programming; check for transients
0x807B outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_0OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8095 10 Failed to disable Monitor related power supplies that cause the
0x8096 FPGA Array. Unstable VPUMP issue during programming; check for transients
0x8097 voltage level. outside of Microsemi specifications. See your
device datasheet for more information on
Unstable VCC transient specifications.
Unstable VCC_OSC | Monitor VJTAG during programming; measure
(Fusion only) JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8061 10 Failed to program Unstable VPUMP Monitor related power supplies that cause the
0x8062 FlashROM. voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_0OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x801B 10 Error programming Unstable Monitor related power supplies that cause the
0x801C Embedded Flash VCC_NVM/VCC_OS | issue during programming; check for transients
0x806C C voltage level outside of Microsemi specifications. See your
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
0x806D Memory Block (Fusion only) device datasheet for more information on
0x806E (EFMB) transient specifications.
Unstable
VCC_ENVM/VCC_R | Monitor VIJTAG during programming; measure
COSC voltage level | JTAG signals for noise or reflection.
(SmartFusion only)
Reset signal is not properly tied off in your
Signal integrity design.
issues on JTAG pins
NVM corruption is Inspect device using Device Debug.
possible when
writing from your
design; check the
NVM status for
confirmation.
0x807D 10 Error programming Unstable VCC Monitor related power supplies that cause the
0x807E system init and boot issue during programming; check for transients
clients Unstable VCC_OSC | outside of Microsemi specifications. See your
(Fusion only) device datasheet for more information on
transient specifications.
Unstable
VCC_ROSC voltage | Monitor VITAG during programming; measure
level (SmartFusion JTAG signals for noise or reflection.
only)
Signal integrity Inspect device using Device Debug.
issues on JTAG pins
0x8069 10 Error programming Programming file Generate STAPL file with the latest version of
0x806A Embedded Flash generated with an Designer/FlashPro; use the latest version of
0x806B Memory Block older version of FlashPro software
(EMFB) software
Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x808E 10 Error programming Try reprogramming
0x808F Embedded Flash
0x8090 Memory Block Contact Microsemi Technical Support
0x8091 (EFMB)
0x807F 10 Error programming Programming file Generate STAPL file with the latest version of
0x8080 system init and boot | generated with an Designer/FlashPro; use the latest version of

clients

older version of
software

FlashPro software

Try again at a slower TCK

Inspect device using Device Debug.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
Contact Microsemi Technical Support
0x8059 11 Verify O failed at row | Unstable VPUMP Monitor related power supplies that cause the
0x805B <row number> voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Verify 1 failed at row | Unstable VCC device datasheet for more information on
<row number>. transient specifications.
Unstable VCC_0OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8060 11 Device is Run VERIFY_DEVICE_INFO to verify the
Failed to verify programmed with a | device is programmed with the correct
FlashROM at row different design. data/design.
<FlashROM row
number>. Unstable VPUMP Monitor related power supplies that cause the
voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8075 11 Failed to verify Device is Verify the device is programmed with the correct
0x8076 Embedded Flash programmed with a | data/design.
0x8077 Memory Block different design.

(EFMB)

Unstable VCC

Unstable
VCC_NVM/VCC_OS
C (Fusion only)

Unstable
VCC_ENVM/VCC_R
OSC voltage level
(SmartFusion only)

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Measure JTAG pins, and noise or reflection.
Run DEVICE_INFO to confirm if the target

EFMB block is locked with FlashLock (pass
key). If the target EFMB block is locked, then
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Error Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

Signal integrity
issues on JTAG
pins.

The EFMB data was
modified in your
FPGA design after
programming. This
could have occurred
during standalone
verify.

The target EFMB is
locked with
FlashLock when
running ACTION
PROGRAM_NVM_A
CTIVE_ARRAY or
VERIFY_NVM_ACTI
VE_ARRAY.

you must unlock it by erasing the security and
then reprogramming with the desired security
settings. After unlocking the target EFMB block
attempt to rerun the target ACTION.

Inspect device using Device Debug.

0x8085
0x8086

11

Failed to verify
system init and boot
clients

Device is
programmed with a
different design.

Unstable VCC

Unstable
VCC_NVM/VCC_OS
C (Fusion only)

Unstable
VCC_ENVM/VCC_R
OSC voltage level
(SmartFusion only)

Signal integrity
issues on JTAG
pins.

The EFMB data was
modified in your
FPGA design after
programming. This
could have occurred
during standalone
verify.

The target EFMB is
locked with
FlashLock when
running ACTION
PROGRAM_NVM_A
CTIVE_ARRAY or

Verify the device is programmed with the correct
data/design.

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Measure JTAG pins, and noise or reflection.

Run DEVICE_INFO to confirm if the target
EFMB block is locked with FlashLock (pass
key). If the target EFMB block is locked, then
you must unlock it by erasing the security and
then reprogramming with the desired security
settings. After unlocking the target EFMB block
attempt to rerun the target ACTION.

Inspect device using Device Debug.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
VERIFY_NVM_ACTI
VE_ARRAY.
0x8072 11 Failed to verify Programming file Generate STAPL file with the latest version of
0x8073 Embedded Flash generated with an Designer/FlashPro; use the latest version of
0x8074 Memory Block older version of FlashPro software
(EFMB) software
Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8083 11 Failed to verify Programming file Generate STAPL file with the latest version of
0x8084 system init and boot | generated with an Designer/FlashPro; use the latest version of
clients older version of FlashPro software
software
Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8014 11 Failed to verify Unstable VCC Monitor related power supplies that cause the
0x8015 calibration data issue during programming; check for transients
Unstable outside of Microsemi specifications. See your
VCC_NVM/VCC_OS | device datasheet for more information on
C (Fusion only) transient specifications.
Unstable Monitor VITAG during programming; measure
VCC_ENVM/VCC_R | JTAG signals for noise or reflection.
OSC voltage level
(SmartFusion only) | Try reprogramming.
Signal integrity Workaround: Disable optional procedure
issues on JTAG pins | CHECK_AND_BACKUP_CALIB
0x805A 11 Verify O failed at row | Device is Run VERIFY_DEVICE_INFO to verify the
0x805C <row number> . programmed with a | device is programmed with the correct

Verify 1 failed at row
<row number>

different design

Unstable VPUMP
voltage level.

Unstable VCC

Unstable VCC_OSC
(Fusion only)

Unstable
VCC_ROSC voltage
level (SmartFusion

only)

data/design.

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
Signal integrity
issues on JTAG pins
0x8063 14 Failed to program Signal integrity Monitor related power supplies that cause the
Silicon Signature. issues on JTAG issue during programming; check for transients
Failed to program pins. outside of Microsemi specifications. See your
security lock settings. device datasheet for more information on
transient specifications.
Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
0x8068 -18 Failed to authenticate | Incorrect AES key. Generate a programming file with the correct
the encrypted data. AES key.
Signal integrity
issues on JTAG Monitor VITAG during programming; measure
pins. JTAG signals for noise or reflection.
0x805F -20 Failed to verify Programming file Generate STAPL file with the latest version of
FlashROM at row generated with an Designer/FlashPro; use the latest version of
<FlashROM row older version of FlashPro software.
number>. software
Program with the correct data/design.
Device is
programmed with a | Monitor related power supplies that cause the
different design. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VPUMP device datasheet for more information on
voltage level. transient specifications.
Unstable VCC Measure JTAG pins and noise or reflection.
Unstable VCC_0OSC
(Fusion only)
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8065 -22 Failed to program Unstable VPUMP Monitor related power supplies that cause the
pass key. voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on

Unstable VCC_0OSC
(Fusion only)

Unstable
VCC_ROSC voltage

transient specifications.

Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8066 -23 Failed to program Unstable VPUMP Monitor related power supplies that cause the
AES key. voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_0OSC
(Fusion only) Measure JTAG pins and noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG
pins.
0x8055 -24 Failed to program Unstable VPUMP Monitor related power supplies that cause the
0x8056 UROW. voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage | Make sure you mounted 0.01uF and 0.33uF
level (SmartFusion caps on Vpump (close to the pin).
only)
Signal integrity
issues on JTAG
pins.
0x802A -27 FlashROM File contains no Provide a programming file with a passkey that
Write/Erase is passkey and device | matches the passkey programmed into the
protected by the is secured with a device.
passkey. passkey.
A valid passkey
needs to be Passkey in the file
provided. does not match
device.
0x8025 -28 FPGA Array File contains no Provide a programming file with a passkey that

Write/Erase is
protected by the
passkey.

A valid pass key

passkey and device
is secured with a
passkey.

Passkey in the file

matches the passkey programmed into the
device.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
needs to be does not match
provided. device.
0x802B -29 FlashROM Read is File contains no Provide a programming file with a pass key that
0x802D protected by passkey and device | matches the passkey programmed into the
passkey. is secured with a device
A valid passkey passkey.
needs to be Passkey in the file
provided. does not match
device.
0x8024 -30 FPGA Array File contains no Provide a programming file with a passkey that
0x8026 verification is passkey and device | matches the passkey programmed into the
protected by a is secured with a device.
passkey. passkey.
A valid passkey Passkey in the file
needs to be does not match
provided. device.

-31 Failed to verify AES | AES key in the file Provide a programming file with an AES key
0x804B key. does not match the | that matches the AES key programmed into the
0x8001 device. device.
0x8007

Unstable VCC Monitor related power supplies that cause the
issue during programming; check for transients
Unstable VCC_OSC | outside of Microsemi specifications. See your
(Fusion only) device datasheet for more information on
transient specifications.
Unstable
VCC_ROSC voltage | Monitor VITAG during programming; measure
level (SmartFusion JTAG signals for noise or reflection.
only)
Unstable
JTAG/VPUMP
voltage level.
0x8000 -31 Failed to verify AES | Programming file Generate STAPL file with the latest version of
key. generated with an Designer/FlashPro; use the latest version of
older version of FlashPro software.
software
Try again at a slower TCK
Contact Microsemi Technical Support
0x8020 -33 FPGA Array File contains Provide a programming file with an encrypted
0x8022 encryption is unencrypted array FPGA Array data.
0x8028 enforced. A data, but device
programming file with | contains AES key.
encrypted FPGA
array data needs to
be provided.
0x802C -34 FlashROM File contains Provide a programming file with an encrypted
0x802F encryption is unencrypted FlashROM data.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
enforced. A FlashROM data, but
programming file with | the device contains
encrypted FlashROM | an AES key.
data needs to be
provided.
0x801F -35 Failed to match pass | Pass key in file does | Provide a programming file with a pass key that
0x804A key. not match pass key | matches the pass key programmed into the
in device. device.
0x802E -36 FlashROM File contains Regenerate security programming file with
0x8030 Encryption is not encrypted proper AES key.
enforced. FlashROM, but
device encryption is | Program device security.
Cannot guarantee not enforced for
valid AES key FlashROM Retry programming FlashROM with encrypted
present in target programming file.
device.
Unable to proceed
with Encrypted
FlashROM
programming.
0x8021 -37 FPGA Array File contains Regenerate security programming file with
0x8023 Encryption is not encrypted FPGA proper AES key.
0x8027 enforced. Array, but the device
0x8029 encryption is not Program device security.
Cannot guarantee enforced for FPGA
valid AES key Array. Retry programming FPGA Array with encrypted
present in target programming file.
device.
Unable to proceed
with Encrypted FPGA
Array verification.
0x8067 -38 Failed to program Unstable VPUMP Monitor related power supplies that cause the
pass key. voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Unstable VCC device datasheet for more information on

Unstable VCC_0OSC
(Fusion only)

Unstable
VCC_ROSC voltage
level (SmartFusion

only)

Signal integrity
issues on JTAG
pins.

Bad device.

transient specifications.

Measure JTAG pins and noise or reflection.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
0x806F -39 ERROR: 2 or more Unstable Monitor related power supplies that cause the
0x8070 errors found on this | VCC_NVM/VCC_OS | issue during programming; check for transients
0x8071 page C voltage (Fusion outside of Microsemi specifications. See your
0x8081 only) device datasheet for more information on
0x8082 transient specifications.
0x8089 Unstable
VCC_ENVM/VCC_R | Bias NVM reset to a logic state in user design.
OSC (SmartFusion
only) Try reprogramming.
NVM reset signal is
floating in user
design
2 or more ECC
errors found when
reading the eNVM
0x8010 -39 ERROR: 2 or more 2 or more ECC The master calibration data has been corrupted.
errors found on this errors found when Try restoring master calibration from backup, if it
page. reading the master exists, by running RECOVER_CALIB.
calibration data
Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x8013 -39 ERROR: 2 or more 2 or more ECC Rerun action to attempt to write backup
errors found on this errors found when calibration again.
page. verifying the backup
calibration Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x8078 -40 Embedded Flash Data in the file is Verify the programming file is generated from
0x8079 Memory Block MAC | encrypted with a the latest version of Designer/FlashPro.
0x807A Failure. different AES key
0x8087 than the device.
0x8088
0x8002 -42 Failed to verify File security settings | Provide a programming file with security setting
0x8003 security settings. do not match device. | that match the security settings programmed
into the device.
0x8093 -42 Failed to verify Device eNVM/EFMB | Verify the device is programmed with the correct
eNVM/EFMB client client JTAG eNVM/EFMB client JTAG protection settings
JTAG protection protection settings
settings are not programmed
or are programmed
with different settings
0x8004 -43 Failed to verify File checksum and Verify the device is programmed with the correct

design information.

design name do not
match the device.

data and design.
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
0x8049 -44 Failed to verify AES | The AES key in the | Provide a programming file with an AES key
key. file does not match that matches the AES key programmed into the
the AES key in the device.
device.
File does not
contain an AES key
and the device is
secured with an AES
key.
0x8054 -45 Device package does | Programming file Generate STAPL file with the latest version of
not match the was generated with | Designer/FlashPro; use the latest version of
programming file. an older version of FlashPro software.
software
0x8033 -46 Embedded Flash File contains no pass | Provide a programming file with the correct pass
0x8038 Memory Block X key or incorrect pass | key.
0x803D Read is protected by | key but EFMB read
0x8042 pass key. A valid is secured with a
0x8045 pass key needs to be | pass key.
0x8046 provided.
0x8047
0x8048
0x8034 -46 Embedded Flash File contains Regenerate security programming file with the
0x8039 Memory Block encrypted EFMB for | proper AES key.
0x803E (EFMB) block X block X but the
0x8043 Read is not protected | device encryption is | Program device security. Retry programming
by pass key. not enforced for with EFMB block X with encrypted programming
EFMB block X. file.
EFMB content is not
secure after
encrypted
programming.
Unable to proceed
with encrypted NVM
programming.
0x8032 -47 Embedded Flash The programming Provide a programming file with encrypted
0x8037 Memory Block EFMB data is not EFMB data.
0x803C (EFMB) block X encrypted, but the
0x8041 encryption is device contains an
enforced. A AES key with
programming file with | encryption enforced.
encrypted EFMB
data needs to be
provided.
0x8031 -48 Embedded Flash File contains no pass | Provide a programming file with a passkey that
0x8036 Memory Block key or incorrect pass | matches the passkey programmed into the
0x803B (EFMB) block X key, but device is device.
0x8040 Write is protected by | secured with a pass

pass key.

key.
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Code
A valid pass key
needs to be
provided.
0x8035 -49 Embedded Flash File contains Regenerate security programming file with
0x803A Memory Block encrypted EFMB for | proper AES key.
0x803F (EFMB) block X block X, but the
0x8044 Encryption is not device encryption is | Program device security. Retry programming
enforced. not enforced for EFMB block X with encrypted programming file.
EFMB block X.
Cannot guarantee
valid AES key
present in target
device.
Unable to proceed
with Encrypted
EFMB programming.
0x801A -50 No backup No backup If master copy is still intact, rerun Action to
calibration data found | calibration copy has | create backup calibration copy.
or backup calibration | been made or the
data has been backup copy has Workaround: Disable optional procedure
corrupted been corrupted CHECK_AND_BACKUP_CALIB
8x804E -51 Failed to access This version of the If programming the EFMB while the FPGA is
Embedded Flash silicon does not active is not required, then use actions
Memory. support PROGRAM_NVM or VERIFY_NVM. Otherwise,
(AFS600 only) programming of the | use latest revision of silicon.
Embedded Flash
Memory Block while
the FPGA Array is
active.
0x804F -52 Failed to access This version of the If programming the EFMB while the FPGA is
Embedded Flash silicon does not active is not required, then use actions
Memory. support PROGRAM_NVM or VERIFY_NVM. Otherwise,
(AFS1500 only) programming of the | use latest revision of silicon.
Embedded Flash
Memory Block while
the FPGA Array is
active.
0x8050 -53 Failed to access This version of the If programming the EFMB while the FPGA is
Embedded Flash silicon does not active is not required, then use actions
Memory. support PROGRAM_NVM or VERIFY_NVM. Otherwise,
(AFS1500 only) programming block 3 | use EFMB blocks 0, 1, or 2, but do not use
of the EFMBs while | block 3.
the FPGA Array is
active.
0x8051 -54 Failed to access FPGA Array is If programming the EFMB while the FPGA is

Embedded Flash
Memory.

accessing the target
EFMB block while

active is not required, then use actions
PROGRAM_NVM or VERIFY_NVM. Otherwise,
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Error Code Exit Exit Message Possible Cause Possible Solution
Code
attempting check the FPGA design or use a different EFMB
programming. block that is not being accessed. Check if target
EFMB block logic is tied to reset.
NVM reset signal is
stuck in design. Monitor related power supplies that cause the
issue during programming; check for transients
Unstable VCC outside of Microsemi specifications. See your
device datasheet for more information on
MSS Clock is transient specifications.
disabled during
programming. Verify that the NVM reset signal in the design is
not stuck.
MSS Clock is not
properly routed to Verify the MSS clock is enabled during
the correct pin. programming.
If the MSS clock is defined as an external 1/O,
then verify that it is properly routed to the
correct pin.
0x808A -55 Failed to read Programming file Generate STAPL file with the latest version of
0x8094 Embedded Flash generated with an Designer/FlashPro; use the latest version of
Memory Block older version of FlashPro software
(EFMB) software
Try again at a slower TCK
Inspect device using Device Debug
Contact Microsemi Technical Support
0x808B -55 Failed to read Unstable VPUMP Monitor related power supplies that cause the
Embedded Flash voltage level. issue during programming; check for transients
Memory Block outside of Microsemi specifications. See your
(EFMB) Unstable VCC device datasheet for more information on
transient specifications.
Unstable VCC_0OSC
(Fusion only) Monitor VITAG during programming; measure
JTAG signals for noise or reflection.
Unstable
VCC_ROSC voltage
level (SmartFusion
only)
Signal integrity
issues on JTAG pins
0x808C -55 Failed to read Internal errror Contact Microsemi Technical Support
Embedded Flash
Memory Block
(EFMB)
0x8011 -56 Failed to read Try reprogramming.

calibration data

Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
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Code
0x8012 -56 Failed to read Unstable VCC Monitor related power supplies that cause the
calibration data issue during programming; check for transients
Unstable outside of Microsemi specifications. See your
VCC_NVM/VCC_OS | device datasheet for more information on
C (Fusion only) transient specifications.
Unstable Measure JTAG voltages, noise, and reflection.
VCC_ENVM/VCC_R
OSC voltage level Try reprogramming.
(SmartFusion only)
Workaround: Disable optional backup procedure
Signal integrity CHECK_BACKUP_CALIB
issues on JTAG pins
0x808D -57 eNVM/EFMB is File contains no Provide a programming file with a Pass Key that
0x8092 protected by a Pass | Pass Key and device | matches the Pass Key programmed into the
Key; you must is secured with a device
provide a valid Pass | Pass Key
Key
Pass Key in the file
does not match
device

Exit Codes for pre-v8.6 Software (SmartFusion, IGLOO, ProASIC3

and Fusion)

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in pre-v8.6 software only.
This includes v8.5 SP2, v8.5 SP1, v8.5, etc. See the Device Exit Codes for Software v8.6 and Above help topic

for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 4 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in pre-v8.6 Software

Exit Exit Message Possible Cause Possible Solution
Code
0 Passed (no error).
1 A physical chain does Physical chain
not match the expected | configuration has been
set up from the STAPL | altered. Something has
file. become disconnected in
Also known as Checking | the chain.
Chain Error. The specific IR length of
non-Microsemi devices
may be incorrect.
The order of the specified
chain may be incorrect.
5 Failed to enter Monitor VPUMP voltage during programming
programming mode. Unstable VPUMP voltage
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Exit Exit Message Possible Cause Possible Solution
Code
level. Measure JTAG voltages, noise, and reflection.
Signal integrity issues on Generate STAPL file with the latest version of
JTAG pins. Designer/FlashPro.
Use latest version of FlashPro software.
Older software or
programming file used.
6 Failed to verify IDCODE. Measure JTAG pins, noise and reflection.
Signal integrity issues on
JTAG pins.
8 Failed Erase Operation. | Signal integrity issues on Monitor VPUMP voltage during programming.
JTAG pins. Measure JTAG voltages, noise, and reflection.
10 Failed to program FPGA | Signal integrity issues on Monitor VPUMP voltage during programming.
array at row ", JTAG pins. Measure JTAG voltages, noise, or reflection.
rowNumber,"."
10 Failed to enable FPGA | Signal integrity issues on Monitor VPUMP voltage during programming.
Array. JTAG pins. Measure JTAG voltages, noise, or reflection.
10 Failed to program Signal integrity issues on Monitor VPUMP voltage during programming.
FlashROM. JTAG pins. Measure JTAG voltages, noise, and reflection.
11 Verify 0 failed at Device is programmed Run VERIFY_DEVICE_INFO to verify the device is
row",rowNumber,"." with a different design. programmed with the correct data/design.
Verify 1 failed at Monitor VPUMP voltage during programming.
row",rowNumber,"." Signal integrity issues on Measure JTAG voltages, noise and reflection .
Failed to verify JTAG pins.
FlashROM at row",from
rowNumber-1.
14 Failed to program Silicon | Signal integrity issues on Monitor VPUMP voltage during programming.
Signature. JTAG pins. Measure JTAG voltages, noise, and reflection.
Failed to program
security lock settings.
-18 Failed to authenticate Incorrect AES key. Generate a programming file with the correct AES key.
the encrypted data.
Signal integrity issues on Measure JTAG voltages, noise and reflection
JTAG pins.
-20 Failed to verify Device is programmed Program with the correct data/design.
FlashROM at row ", with a different design.
FRomRowNumber-1. Monitor VPUMP level during programming.
Signal integrity issues on Measure JTAG pins and noise or reflection.
JTAG pins.
-22 Failed to program pass | Unstable VPUMP voltage | Monitor VPUMP voltage during programming.

key.

level.

Signal integrity issues on
JTAG pins.

Measure JTAG voltages, noise, and reflection.
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Exit Exit Message Possible Cause Possible Solution
Code
-23 Failed to program AES Unstable VPUMP voltage | Monitor VPUMP voltage during programming.
key. level.
Measure JTAG pins and noise or reflection.
Signal integrity issues on
JTAG pins.
-24 Failed to program Unstable VPUMP voltage | Monitor VPUMP voltage during programming.
UROW. level.
Measure JTAG voltages, noise, and reflection.
Signal integrity issues on Make sure you mounted 0.01iF and 0.33iF caps on Vpump
JTAG pins. (close to the pin).
-25 Failed to enter Signal integrity issues on Measure JTAG voltages, noise, and reflection.
programming mode JTAG pins.
-26 Failed to enter Signal integrity issues on Measure JTAG voltages, noise, and reflection.
programming mode JTAG pins.
-27 FlashROM Write/Erase | File contains no passkey Provide a programming file with a passkey that matches
is protected by the and device is secured with | the passkey programmed into the device.
passkey. a passkey.
A valid passkey needs to [ Passkey in the file does
be provided. not match device.
-28 FPGA Array Write/Erase | File contains no passkey Provide a programming file with a passkey that matches
is protected by the and device is secured with | the passkey programmed into the device.
passkey. a passkey.
A valid pass key needs [ Passkey in the file does
to be provided. not match device.
-29 FlashROM Read is File contains no passkey Provide a programming file with a pass key that matches
protected by passkey. and device is secured with | the passkey programmed into the device
A valid passkey needs to | a passkey.
be provided. Passkey in the file does
not match device.
-30 FPGA Array verification | File contains no passkey Provide a programming file with a passkey that matches
is protected by a and device is secured with | the passkey programmed into the device.
passkey. a passkey.
A valid passkey needs to | Passkey in the file does
be provided. not match device.
-31 Failed to verify AES key. | AES key in the file does Provide a programming file with an AES key that matches
not match the device. the AES key programmed into the device.
Unstable JTAG/VPUMP Monitor VPUMP/VJTAG voltage during programming.
voltage level.
Measure JTAG voltages, noise, and reflection.
-32 Failed to verify IDCODE. | File is not for M7, but Check that the target device is M7 enabled.

Target is an M7 device

target device is an M7.

Signal integrity issues on
JTAG pins.

Make sure programming file generated is for M7 enabled
device.

Measure JTAG pins , noise, and reflection.
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Exit Exit Message Possible Cause Possible Solution
Code
-32 Failed to verify IDCODE. | File is not for M1, but Check that the target device is M1 enabled.
Target is an M1 device | target device is an M1 Make sure programming file generated is for M1 enabled
device. device.
Signal integrity issues on Measure JTAG pins, noise, and reflection.
JTAG pins.
-32 Failed to verify IDCODE. | File is not for target device. | Check the target device. Make sure programming file
Core enabled device generated for target device.
detected Signal integrity issues on
JTAG pins Measure JTAG voltages, noise, and reflection.
-32 Failed to verify IDCODE. | File is for M7, but target Check that the target device is not M7 enabled.
The target is not an M7 | device is not M7. Make sure programming file generated is for non M7
device enabled device.
Signal integrity issues on
JTAG pins. Measure JTAG voltages, noise, and reflection.
-32 Failed to verify IDCODE. | File is for M1, but target Check that the target device is not M1 enabled.
The target is not an M1 | device is not an M1 Make sure programming file generated is for non M1
device device. enabled device.
Signal integrity issues on Measure JTAG voltages, noise and reflection.
JTAG pins.
-33 FPGA Array encryption | File contains unencrypted | Provide a programming file with an encrypted FPGA Array
is enforced. A array data, but device data.
programming file with contains AES key.
encrypted FPGA array
data needs to be
provided.
-34 FlashROM encryption is | File contains unencrypted | Provide a programming file with an encrypted FlashROM
enforced. A FlashROM data, but the data.
programming file with device contains an AES
encrypted FlashROM key.
data needs to be
provided.
-35 Failed to match pass Pass key in file does not Provide a programming file with a pass key that matches
key. match pass key in device. [the pass key programmed into the device.
-36 FlashROM Encryption is | File contains encrypted Regenerate security programming file with proper AES

not enforced.

Cannot guarantee valid
AES key present in
target device.

Unable to proceed with
Encrypted FlashROM
programming.

FlashROM, but device
encryption is not enforced
for FlashROM

key.
Program device security.

Retry programming FlashROM with encrypted
programming file.
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Exit Exit Message Possible Cause Possible Solution
Code
-37 FPGA Array Encryption | File contains encrypted Regenerate security programming file with proper AES
is not enforced. FPGA Array, but the key.
device encryption is not
Cannot guarantee valid | enforced for FPGA Array. | Program device security.
AES key presentin
target device. Retry programming FPGA Array with encrypted
programming file.
Unable to proceed with
Encrypted FPGA Array
verification.
-38 Failed to program pass | Unstable VPUMP voltage | Monitor VPUMP voltage during programming.
key. level.
Measure JTAG pins and noise or reflection.
Signal integrity issues on
JTAG pins.
Bad device.
-39 Failed to verify Device is programmed Verify the device is programmed with the correct
Embedded Flash with a different design. data/design.
Memory Block (EFMB). | Signal integrity issues on
JTAG pins. Monitor VPUMP voltage during programming.
Measure JTAG pins and noise or reflection.
The EFMB data was
modified through user Run DEVICE_INFO to confirm if the target EFMB block is
FPGA design after locked with FlashLock (pass key). If the target EFMB block
programming; this could is locked, then you must unlock it by erasing the security
occur during standalone and then reprogramming with the desired security settings.
verify. After unlocking the target EFMB block attempt to rerun the
target ACTION.
The target EFMB block is
locked with FlashLock
when running ACTION
PROGRAM_NVM_ACTIV
E_ARRAY or
VERIFY_NVM_ACTIVE_A
RRAY.
-40 Embedded Flash Data in the file is Verify the programming file is generated from the latest
Memory Block MAC encrypted with a different | version of Designer/FlashPro.
Failure. AES key than the device.
-41 Error programming Signal integrity issues on Measure JTAG pins and noise or reflection.
Embedded Flash JTAG pins.
Memory Block. (EFMB)
-42 Failed to verify security | File security settings do Provide a programming file with security setting that match
settings. not match device. the security settings programmed into the device.
-43 Failed to verify design File checksum and design | Verify the device is programmed with the correct data and

information.

name do not match the
device.

design.
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Exit Exit Message Possible Cause Possible Solution
Code
-44 Failed to verify AES key. | The AES key in the file Provide a programming file with an AES key that matches
does not match the AES the AES key programmed into the device.
key in the device.
File does not contain an
AES key and the device is
secured with an AES key.
-45 Device package does
not match the
programming file.
-46 Embedded Flash File contains no pass key | Provide a programming file with the correct pass key.
Memory Block X Read is | or incorrect pass key but
protected by pass key. A | EFMB read is secured with
valid pass key needs to | a pass key.
be provided.
-47 Embedded Flash The programming EFMB Provide a programming file with encrypted EFMB data.
Memory Block, block X | data is not encrypted, but
encryption is enforced. A | the device contains an
programming file with AES key with encryption
encrypted EFMB data enforced.
needs to be provided.
-48 Embedded Flash File contains no pass key | Provide a programming file with a passkey that matches
Memory Block (EFMB) or incorrect pass key, but | the passkey programmed into the device.
block X Write is device is secured with a
protected by pass key. pass key.
A valid pass key needs
to be provided.
-49 Embedded Flash File contains encrypted Regenerate security programming file with proper AES
Memory Block (EFMB) EFMB for block X, but the | key.
block X Encryption is not | device encryption is not
enforced. enforced for EFMB block Program device security. Retry programming EFMB block
X. X with encrypted programming file.
Cannot guarantee valid
AES key present in
target device.
Unable to proceed with
Encrypted EFMB
programming.
-51 Failed to access This version of the silicon | If programming the EFMB while the FPGA is active is not

Embedded Flash
Memory.
(AFS600 only)

does not support
programming of the
Embedded Flash Memory
Block while the FPGA
Array is active.

required, then use actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, use latest revision of silicon.
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Exit Exit Message Possible Cause Possible Solution
Code
-52 Failed to access This version of the silicon | If programming the EFMB while the FPGA is active is not
Embedded Flash does not support required, then use actions PROGRAM_NVM or
Memory. programming of the VERIFY_NVM. Otherwise, use latest revision of silicon.
(AFS1500 only) Embedded Flash Memory
Block while the FPGA
Array is active.
-53 Failed to access This version of the silicon | If programming the EFMB while the FPGA is active is not
Embedded Flash does not support required, then use actions PROGRAM_NVM or
Memory. programming block 3 of VERIFY_NVM. Otherwise, use EFMB blocks 0, 1, or 2, but
(AFS1500 only) the EFMBs while the do not use block 3.
FPGA Array is active.
-54 Failed to access FPGA Array is accessing | If programming the EFMB while the FPGA is active is not
Embedded Flash the target EFMB block required, then use actions PROGRAM_NVM or
Memory. while attempting VERIFY_NVM. Otherwise, check the FPGA design or use
programming. a different EFMB block that is not being accessed. Check if
target EFMB block logic is tied to reset.
NVM reset signal is stuck
in design. Verify that the NVM reset signal in the design is not stuck.

Exit Codes (ProASICerius)

The table below lists the exit codes for ProASICPLYUS devices.
Table 5 - ProASICPs Family Devices Exit Codes

Exit Code Exit Message Possible Cause Possible Solution
0 This message means
passed. This does not
indicate an error.
1 A physical chain does | Physical chain configuration
not match the expected | has been altered. Something
set up from the STAPL [ has become disconnected in
file. the chain.
Also known as The specific IR length of non-
Checking Chain Error. | Microsemi devices may be
incorrect.
The order of the specified
chain may be incorrect.
2 There is a reading The device either does not Check the device ID.
device ID failure. have a valid device ID or the
data cannot be read correctly.
3 This occurs when Connect was set up for a Set up for a ProASICPLUS device.

using ProASICPLYs
devices.

ProASIC device and the
device is actually
ProASICPLUS,
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Exit Code Exit Message

Possible Cause

Possible Solution

5 Programming set up
problem. Also known
as Entering ISP
Failure.

The A500K device senses the
VDDL power supply as being
on.

Power the VDDL down during programming.
Check the device has the correct voltages on
VDDP, VDDL, VPP, and VPN.

6 The IDCODE of the
target device does not
match the expected

This is a JEDEC
standard message.

value in the STAPL file.

The device targeted in the
STAPL file does not match
the device being
programmed.

User selected wrong device.
Device TRST pin is grounded.
Noise or reflections on one or
more of the JTAG pins
caused by the IR Bits reading
it back incorrectly.

Choose the correct STAPL file and select the
correct device.

Measure JTAG pins and noise or reflection.
TRST should be floating or tied high.

Cut down the extra length of ground
connection.

7 Unknown algorithm:
alg=x, prev=x Invalid
data read from device

This occurs with current
STAPL files when the revision
written into the factory row is
not rev 1 for ProASICPLUS
devices. The STAPL files
from last year may "exit 7"
with newer devices or the
older revision may cause this
failure if the STAPL file used
is from latest version.

This error can also occur if
the programmer has trouble
reading the factory row due to
signal noise, crosstalk, or
reflections on the JTAG signal
and clock lines.

It can occur if you program a -
F ProASICPLUS device with
an old STAPL file.

This error occurs if you
connected VPP and VPN the
wrong way.

It occurs if there are no
bypass Caps on VPP VPN,
which damaged the device.

This error may occur if your
power supply cannot source
the correct current for
programming.

Re-generate STAPL file from Designer 6.1
SP1.

Double check VPP and VPN connections.
Make sure VPP and VPN have correct
bypass caps.

Make sure that your power supply can deliver
the correct current during programming.

8 FPGA failed during the
erase operation.

The device is secured, and
the corresponding STAPL file
is not loaded.

The device has been
permanently secured and
cannot be unlocked.

Load the correct STAPL file.
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Exit Code

Exit Message

Possible Cause

Possible Solution

11

FPGA failed verify

The device is secured and the
corresponding STAPL file is
not loaded.

You used the Libero IDE
software v2.3 or earlier or the
Designer R1-2003 software or
earlier to generate the STAPL
file.

VPN caps were soldered in
the wrong polarity.

Load the correct STAPL file.

Use later software versions —at least Libero
v2.3 SP1 and Designer R1-2003 SP1.
Double-check the VPN bypass caps polarity.

12

Security is enabled.

The device is secured and the
wrong key/STAPL file was
entered.

The device is damaged.

The verification was
interrupted and therefore fails,
causing the software to think
the device is secure.

14

Program security
failure.

15

This is a factory
Calibration Data CRC
error.

During program, erase, or
verify, you must read back
Calibration Data from the
FPGA. The data contains a
CRC. You use the CRC to
ensure the data is not
corrupted/wrong.

Device is damaged.

Noise on the FTAL signals
causes the programmer to
read back wrong data.

17

The device has been
secured. Write-security
is enabled.

The device is secured and the
wrong key or STAPL file was
entered.

The device is damaged.

Load the correct STAPL file.

-54

Failed to access
Embedded Flash
Memory

Analog power supplies
(Vccl5A, Vee33A, GNDAQ
and GNDA) are not
connected.

Connect the analog power supplies (Vcc15A,

Vcec33A, GNDAQ and GNDA)

-90

Unexpected RCK
detected.

Noise on the RCK signal.
You connected a CLK source
to the RCK signal.

The polarized bypass
capacitors on VPP or VPN
are reversed-biased and are
affecting the programmer’s
VPP or VPN output voltage.
This causes programming to
fail. Several FlashPros are

Disconnect the RCK and make sure TCK has

a clean signal.

Separate FlashPros away from each other
while they are programming Internal ISP.
Connect programmer as an Admin in

FlashPro.
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Exit Code Exit Message

Possible Cause

Possible Solution

programming at the same
time and are too close to

each other.

Programmer not properly
installed by Admin.

-91 Calibration data parity | Device is damaged. Replace the device.
error.
Null Several FlashPros are

programming at the same
time and are too close to
each other.

FlashPro connects to PC
parallel port through a dongle
key.

Data length mismatch when
performing DRSCAN on
STAPL file.

Cable to target is not
connected properly.

When the Analyze command
is executed, the FlashPro
looks for target devices. If the
cable connection is wrong,
FlashPro assumes that
nothing is connected at all.

Confirm the connection between the header
to the device. If the board supplies the power
to the device, make sure the voltage level is
correct.

Chain integrity test
failed: xx

The connection between the
FlashPro programmer and the
device is broken.

The programmer cable might
not be securely inserted into
the header.

The header is not connected
to the JTAG pins of the FPGA
correctly.

The configuration setting
(ProASIC/ProASICPLUS)
does not match the target
device.

Noise or reflections on the
JTAG pins has caused
communication between the
programmer and the device to
fail.

A dongle is plugged in
between the PC parallel port
and the FlashPro parallel port
cable.

Secure the connections.

Check the JTAG pins for signal activity.
Check for broken TDO, TMS, and TCK pins.
After checking all type of connections if the
failure exists, you may need to replace the
first device (the devices closest to the TDO of
the programming header) in the chain.
Remove the dongle.

Could not connect to
programmer on port
Ip1 or parallel port
device does not
support IEEE-1284
negotiation protocol

The remote device does not
respond to the negotiation
protocol, for a variety of
reasons.

Make sure the port is connected.

Make sure the connected device is a
FlashPro/Lite programmer.

Turn the programmer on.

Check parallel port setting in BIOS.
Make sure that there are no dongles in
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Exit Code Exit Message

Possible Cause

Possible Solution

between the parallel port and the FlashPro
connection.

Try another parallel cable, the parallel cable
might be defective.

Check to see if the programmer is damaged.
Make sure the FlashPro Lite has power. The
FlashPro Lite is powered from the target
board through the Vdd pin of the
programming header.

Make sure the Vdd pin is connected and the
target board is powered up.

Secure the connection between the cable
connector and the programming header.
Before you program any devices, you should
run the self-diagnostic test. The diagnostic
software can be found on the Microsemi web
site. If the test fails, please contact Microsemi
Customer Technical Support at
tech@Microsemi.com for credit and
replacement.

Note: The Self-test is only available for
FlashPro, not FlashPro Lite.

External voltage
detected on <Supply>

The voltage supply for the
FPGA is driven by another
source (board, external
power-supply), but the user
forgot to turn off the supply in
the Connect menu.

Set appropriate options in the Connect menu.

VDPP Disconnected.

There is no Vddp voltage
supply to the FPGA.

You accidentally turned off
the Vddp supply in the
Connect menu.

The Vddp supply on the
board is not functioning.

Check the Vddp supply on the board for
appropriate voltages and correct the Connect
menu.

More than one unidentified device.

If you want to perform
an operation on the
ProASIC device, the
rest of the devices in
the chain must be in
bypass mode.

To put devices in
bypass mode, select
Configuration > Chain
Parameter (or click the
Chain Parameter
button in the Single
STAPL Configuration
window), then set the

STAPL settings of Pre IR, Pre
DR, Post IR, and Post DR do
not match the chain
configuration.

One or more of the devices in
the chain is damaged and the
ID CODE cannot be read
back.

Make sure you have set Pre IR, Pre DR, Post
IR, and Post DR to match the chain
configuration. If you are still experiencing the
failure, it is likely that the device's ID CODE
cannot be read and you need to replace the
device.
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Exit Code Exit Message

Possible Cause

Possible Solution

Pre IR, Pre DR, Post
IR or Post DR.

Cannot find the
programmer with ID
XXX

The programmer is removed
from the PC.

Delete programmer (or reconnect
programmer) and select the Refresh
Programmer button. See Connecting
Programmers for more information.

Fatal Error: Please
check programmer set
up.

Software cannot resolve the
error encountered in the
programmer.

Save the project file, restart the software, and
power cycle the programmer.

External voltage xxx
mV is detected on xxx.

You have specified the
programmer to drive the xxx
but external xxx is detected.

Deselect the xxx in the programmer setting.

Executing action xxx
failed.

The STAPL runtime failed.

Executing action xxx
with serial index/action
xx failed.

The STAPL runtime failed.

No Vpump voltage
source is detected.

Select the Vpump in the Programmer setting.
Make sure the external Vpump is properly
turned on.

Vpump short detected.

Use a different programmer. If the problem
persists, check the board layout.

xxx Mhz TCK
frequency in this
STAPL file is not
supported by the
FlashPro Lite detected.
It supports only 4 MHz
TCK frequency.

Check FlashPro Lite version being used. Use
FlashPro Lite Rev C or modify the STAPL file
to 4 MHz.

xxx Mhz TCK
frequency in this
STAPL file is not
supported by the
FlashPro Lite RevC
detected. It supports
only 1, 2 or 4 Mhz TCK
frequency.

Modify STAPL file to 1, 2, or 4 MHz.

Cannot find the serial
Index/Action xxx in
STAPL file.

Mismatch between STAPL file
and the Index/Action
selection.

Make sure the STAPL file was not
overwritten. Save the project with updated
serial/action selection.

Duplicated serial
Index/Action xxx was
removed.

Mismatch between STAPL file
and the Index/Action
selection.

Make sure the STAPL file was not
overwritten. Save the project with updated
serial/action selection.
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Exit Code

Exit Message

Possible Cause

Possible Solution

Using local backup
COpY XXX

Cannot find original copy.

Check for available space on the disk. Check
that write permissions are enabled.

FlashPro cannot
rename the
programmer/device
with an existing name.

Name is already in use.

Create a new name.

FlashPro cannot
rename the
programmer/device
with an invalid
character.

Invalid character used in

programmer/device name.

Do not use invalid characters.

Automatic check for
updates.

FlashPro can check the Microsemi website to
find if an updated version of the software is
available. If you would like to have FlashPro
automatically check for software updates,
choose Preferences from the File menu.
From the Updates tab, you can choose your
automatic software update settings. You can
also select Software Updates from the Help
menu for updates to the FlashPro software.

FlashPro parse error.

FlashPro software failed to
parse the file.

FlashPro does not
support STAPL files for
XXX.

STAPL file not allowed.

Use a STAPL file for your device that is
supported by FlashPro.
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SmartDebug

Microsemi’s SmartDebug tool complements design simulation by allowing verification and troubleshooting at the
hardware level.

SmartDebug can be run in the following modes:
¢ Integrated mode from the Libero Design Flow
e Standalone mode
¢ Demo mode

Integrated Mode

When run in integrated mode from Libero, SmartDebug can access all design and programming hardware
information. No extra setup step is required. In addition, the Probe Insertion feature is available in Debug FPGA
Array.

To open SmartDebug in the Libero Design Flow window, expand Debug Design and double-click SmartDebug
Design.

Standalone Mode

SmartDebug can be installed separately in the setup containing FlashPro, FlashPro Express, and Job Manager.
This provides a lean installation that includes all the programming and debug tools to be installed in a lab
environment for debug. In this mode, SmartDebug is launched outside of the Libero Design Flow. When launched
in standalone mode, you must to go through SmartDebug project creation and import a Design Debug Data
Container (DDC) file, exported from Libero, to access all debug features in the supported devices.

Note: In standalone mode, the Probe Insertion feature is not available in FPGA Array Debug, as it requires
incremental routing to connect the user net to the specified 1/0.

Demo Mode

Demo mode allows you to experience SmartDebug features (Active Probe, Live Probe, Memory Blocks,
SERDES) without connecting a board to the system running SmartDebug.

Note: SmartDebug demo mode is for demonstration purposes only, and does not provide the functionality of
integrated mode or standalone mode.

Note: You cannot switch between demo mode and normal mode while SmartDebug is running.
For detailed information about SmartDebug, refer to the SmartDebug User Guide.
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Electrical Parameters

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming. However,

if there is only one ProASIC3 device on the target board, the FlashPro5/4/3/3X can provide the

VPUMP power supply via the USB port.

Note: The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to

configure the internal input and output buffers to the same IO Voltage levels. The VJTAG pin is only

an input pin to the programmer.
Table 6 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit

Input low voltage, TDO VIL -0.5 0.35*VJTAG \%
Input high voltage, TDO VIH 0.65*VJITAG 3.6 \%
Input current, TDO IL, 1IH -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, operating VPP +3.0 +3.6 \%
Output current, VPUMP IPP 250 mA
VJITAG = 1.5V

Output low voltage, TCK, TMS, TDI, 100uA load | VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 4mA load VOL 0.0 0.30*VJTAG \Y
Output high voltage, TCK, TMS, TDI, 100pA load |V VJITAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 4mA load VOH 0.70*VJITAG VITAG \%
Output current, TCK, TMS, TDI IOL, IOH | -4 +4 mA
VITAG = 1.8V

Output low voltage, TCK, TMS, TDI, 100uA load | VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 6mA load VOL 0.0 0.3 \%
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJITAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 6mA load VOH 1.25 VITAG \Y
Output current, TCK, TMS, TDI IOL, IOH | -6 +6 mA
VITAG = 2.5V

Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
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Description Symbol Min Max Unit
Output low voltage, TCK, TMS, TDI, 8mA load VOL 0.0 0.6 \%
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJITAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 8mA load VOH 1.8 VITAG \%
Output current, TCK, TMS, TDI IOL, IOH |-8 +8 mA
VITAG = 3.3V
Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 8mA load VOL 0.0 0.4 \%
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJITAG-0.2 VITAG \%
Output high voltage, TCK, TMS, TDI, 8mA load VOH 2.4 VITAG \Y
Output current, TCK, TMS, TDI IOL, IOH | -8 +8 mA
DC Characteristics for FlashPro Lite
Table 7 - DC Characteristic for FlashPro Lite
Description Symbol Min Max | Unit

Input low voltage, TDO VIL -0.5 0.7 \%

Input high voltage, TDO VIH 1.7 5.0 \%

Input current, TDO IIL, ITH -10 +10 uA

Input capacitance, TDO 40 pF

Input voltage, VDD, operating (see note) +2.3 +3.5 \%

Input voltage, VDD, power off -1.0 +1.0 \%

Input current, VDD IVDD 500 mA

Output voltage, VPP, operating VPP +15.9 | +16.5 \%

Output voltage, VPN, operating VPN -13.8 | -13.4 \%

Output current, IPP PP 0 35 mA

Output current, IPN IPN 0 -15 mA

Output low voltage, TCK, TMS, TDI, 100uA load VOL 0.0 0.2 \%

Output low voltage, TCK, TMS, TDI, 1mA load VOL 0.0 0.5 \
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Description Symbol Min | Max | Unit

Output low voltage, TCK, TMS, TDI, 2mA load VOL 0.0 0.8 \Y%

Output high voltage, TCK, TMS, TDI, 100uA VOH 2.1 2.5 \

load

Output high voltage, TCK, TMS, TDI, 1mA load VOH 1.9 2.5 \%

Output high voltage, TCK, TMS, TDI, 2mA load VOH 1.6 2.5 \Y%

Output current, TCK, TMS, TDI, nTRST I0L, IOH -2 +2 mA

Note: Up to 3.5 V can be supplied to the FlashPro Lite on the VDD pin. However, if the VDD supply for the
FlashPro is also connected to the APA VDD supply, the voltage for the VDD pin cannot exceed 2.7 V.

DC Characteristics for FlashPro

Table 8 - DC Characteristic for FlashPro

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.30*VDDP |V
Input high voltage, TDO VIH 0.70*VDDP |5.5 \%
Input current, TDO 1L, H -10 +10 UA
Input voltage, VDDP, VDDL 0 5.25 \Y
Input voltage, VPP 0 21.0 \%
Input voltage, VPN -21.0 \%
Input current, VDDP, VDDL, VPN, VP IVCC 5.0 mA
Output voltage range, VDDP VDDP 15 3.3 \%
Output voltage range, VPP VPP 15.0 18.0 \%
Output voltage range, VPN VPN -16.0 -12.0 \%
Output voltage resolution / Acccuracy 100/ £50 mV
Output current, IDDP IDDP -1351 +135 mA
Output current, IDDL IDDL -1351 +135 mA
Output current, IPP IPP -2701% +270 mA
Output current, IPN IPN -270 +270 mA
Output low voltage, TCK, TMS, TDI, OUTO, nTRST | VOL 0.0 0.4 \Y
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Description Symbol Min Max Unit
Output high voltage, TCK, TMS, TDI, OUTO, nTRST | VOH 0.85* +0.3 \%
VDDP VDDP
Output current, TCK, TMS, TDI, OUTO, nTRST I0L, IOH |-12 +12 mA

Note: Note (1): When power supply mode is set to ABI_GROUND.

Note: * - If you want to power-up the device from the board power supply, clear the checkboxes for VDDL
and VDDP. VPP and VPN are required during programming only and are supplied by the FlashPro
programmer.

Note: (2) Microsemi does not have operating temperature information for the FlashPro programmer.
FlashPro is intended to be used as lab or production equipment and not tested at extreme
temperatures. All devices in the unit are commercial temp. FlashPro4 went through a burn-in cycle
operating at 100C for 250 hours during quality testing. This involved repeatedly powering the
programmers and then programming after the burn in; they are not actively programming during the
burn in.
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Electrical Specifications

FlashPro5

The FlashPro5 is a JTAG and a SPI based programmer for flash based Microsemi devices.

The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro5 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer’'s
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10 pin straight header, AMP
P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro5 10-pin connector are shown in the figure below.

TCKSSCK | )
———=TDO/SDO | 3 4
*—msrss#[5 6
a— Vpoump |7 8

ToDIsDl |9 10

GND =
PROG_MODE ———

VITAG —=—

NTRST ——=

GMD -—

Figure 16 - FlashPro5 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 9 - FlashPro5 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
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default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST"” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.
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Electrical Specifications

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro4 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer’'s
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10 pin straight header, AMP
P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version..

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

- TCK|1 2
—= TDO|3 4
-~ TMS [ 5 6
- Veume |7 8
— TDI |9 10

GMD -

PROG_MODE ——

VITAG —~—
ATRST ———
GMD -—

Figure 17 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 10 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
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suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST"” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro3

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10
pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use the 10 pin
straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-~ TCK|1 2 |GND =~
—  TDO|3 4 |N/C

*—TMS[S 6 |VITAG =<——
- Veump |7 8 |nTRST ——
-« TDI|9 10 [GND <+—»

Figure 18 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 11 - FlashPro3 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
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suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST"” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro Lite

For FlashPro Lite, the existing 26-pin connector is shown in the figure below.

N/C|1 2 |IN/C

N/C|3 4 IN/C
N/C|5 6 |Ver —
-~ GND|7 8 |Ven —
-— GNDl9g 10 |[SENSE -—
=-— GND| 11 12 |TCK —
N/C| 13 14 [TDI —
N/C L15 16 |TDO -
-— GND17 18 |[TMS —
-~ GND|[19 20 |OUTO/RCK ——
N/C |21 22 InTRST —
N/C|23 24 |Voo S —
N/C 25 26 Voo -—

Figure 19 - 26-pin Connector for FlashPro Lite

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The appropriate SAMTEC micro connector target cable for this is:
Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board and reducing the
inductance will help compared with 18 inches, which is supplied by the default with FlashPro Lite.

See the table below for a description of the signals.

Table 12 - FlashPro Lite Signal Description

Signal

Description

VDDP

VDD supply for logic I/O pads

VDDL

VDD supply for core

VPP

Positive programming supply (+16.5V)

VPN

Negative programming supply(-13.8V)

GND

Signal reference

SENSE

Input from target board to programmer to indicate connection to
ground

TCK

JTAG clock

TDI

JTAG data input to device

TDO

JTAG data output from device

T™MS

JTAG mode select
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Signal Description

NTRST Programmable output pin may be set to off, toggle, low, or high level

RCK/OUTO Programmable output pin may be set to off, toggle, low, or high level

N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro

For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the connections are
shown in the figure below.

-—  2.5V/3.3V| 2 |Vooe —
-—  2.5\//3.3V|3 4 |Voor .
-—  2.5V/3.3V|5 6 |Vrr E—
- GND|7 8 [Veu —
- - GNDJ g 10 |SENSE -—
—r GND| 11 12 |TCK -

N/C| 13 14 | TDI -

N/CL15 16 |TDO -
-~ GNDI7 18 |TMS -
- GNDI19 20 |RCK/OUTO —
- 2.5V |21 22 InTRST -
-— 2.5V |23 24 |Voou —
R 2.5V |25 26 | VooL —

Figure 20 - 26-pin connections for FlashPro

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows the signal pin descriptions for FlashPro.
Table 13 - FlashPro Signal Description

Signal Description
VDDP VDD supply for logic I/O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5 V)
VPN Negative programming supply (-13.8 V)
GND Signal reference
SENSE Input forlom target board to programmer to indicate connection to
groun
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Signal Description

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

NTRST Programmable output pin may be set to off, toggle, low, or high
level

RCK/OUTO Programmable output pin may be set to off, toggle, low, or high
level

2./5V, 2.5V/3.3V, Programmer does not connect to these pins

N/C

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

JTAG Switching Characteristics

FlashPro 5/4/3/3X Characteristics
Table 14 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VJTAG=3.3 TTDOTCK 12 ns
TDO setup time before TCK rising, VITAG=1.5 TTDOTCK 145 ns
TDO hold time after TCK rising TTCKTDO 0 ns
TCK period TTCK 41.7 10667 ns

FlashPro and FlashPro Lite Characteristics

The table below shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the
programmer end of the JTAG cable.

Table 15 - JTAG Switching Characteristics for FlashPro and FlashPro Lite

Description Symbol Min | Max | Unit
Output delay from TCK falling to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising TTDOTCK 5.0 ns
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Description Symbol Min | Max | Unit
TDO hold time after TCK rising TTCKTDO 0 ns
TCK period TTCK 40 10240 ns

lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

TCK '\_/' \

- [Tk -

TMS, TDI ><

Trexro —=

TTDCTCKA"

TrckToo—m
Figure 21 - JTAG Switching Characteristics
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FlashPro Express Reference

FlashPro Express Start Page

The FlashPro Express Start Page is the first page to show when the tool starts up. This page provides the
interface for loading a project into the tool by either navigating to the project location, or clicking on one of the
recently opened projects.

E FlashPro Express EI@

Project  Edit  View Programmer Help

rogramming ]

Open, .

Recent Projects List

ChUsers\ptgatDesktop'\SaFlashprotdermo_10_dewvices\derno_10_devices.pro -
CihlsersiptgatDesktophSAFlashprottest_agfpitestpro
Civhamdyatderno_10_devices\demo_10_devices.pro
CalifyStand_Alone_FlashPro_Testing'parallel_prograrmingtest_agfpitest.pro
Divternphsdlnewtsdinewpro

S Microsemi

Log B X

@ Errars  §, ‘Warnings 0 Info

Figure 22 - FlashPro Express Start Page

FlashPro Express Project Menu

Command Function
Create Job Project from New job project folder with programming job name will be created at
Programming Job the specified location.
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Command Function

Open Job Project Loads a job project into the tool by reading the information in user
specified .pro file.

Close Job Project Closes the current job project

Save Job Project Saves the current job project

Set Log File Sets the location of the Log file to your specified location.

Export Log File Exports the Log file to your specified location.

Execute Script Runs your specified Tcl script.

Export Script File Exports all commands run in this session to your specified path as a
Tcl script

Exit Exits FlashPro Express

FlashPro Express Edit Menu

Command Function

Clear Log Window Clears the Log window

FlashPro Express View Menu

The View menu shows or hides the FlashPro Express GUI elements.

Command Function

Log Window Shows/hides the Log window

FlashPro Express Tools Menu

Command Function
Programmer Opens the Programmer Settings dialog box; enables you to set options for all types of
Settings supported Microsemi programmers
Run Runs the current Programming Action.
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Command

Function

Help Topics

Opens the help

Microsemi Technical
Support

Opens the Microsemi technical support site.

Microsemi Web Site

Opens the Microsemi website in your default browser

User Guide

Opens the FlashPro Express User Guide.

Check for Software Updates

Checks for software updates (works only if you are connected to the
internet)

About FlashPro Express

Lists the FlashPro Express release information

FlashPro Express Log Window and Status Bar

FlashProExpress Log Window

The FlashPro Express log window shows status messages for user activity. Click on the appropriate tab
(Messages, Errors, Warning, Info) to filter messages by type.

e Use the right-click menu to copy text, clear the log, and scroll the log.
e Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
e Use the View menu to show or hide the Log window.

FlashProExpress Status Bar

The Status Bar at the bottom displays the status of the load project action.
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Contacting Microsemi

Microsemi SoC Products Group Headquarters

Microsemi Corporation is a supplier of innovative programmable logic solutions, including field-programmable
gate arrays (FPGASs) based on antifuse and flash technologies, high-performance intellectual property (IP) cores,
software development tools, and design services targeted for the high-speed communications, application-specific
integrated circuit (ASIC) replacement, and radiation-tolerant markets.

Address: Microsemi SoC Products Group
3870 North First Street
San Jose, CA 95134

Phone: 408-643-6000

Contact Information
For the most up-to-date contact information, check the Microsemi Home Page.
Contact information for FPGAs & SoCs can be found at the FPGAs and SoCs Support Page
If you do not have internet access, the following information was accurate at the time of publication:

e Technical Support
e Web: https://soc.microsemi.com/mycases
e Phone (NA): 800.262.1060
e Phone (Int'l): +1 650.313.4460
e Email: soc_tech@microsemi.com

e Customer (non-technical) Support

e Phone: +1 650.318.2470

e Email: customer.service@microsemi.com
e Sales Support

e For pricing, order status and lead time information for all Microsemi SoC products, contact your
Microsemi Sales Representative

e Technical Support for RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR)

e Phone (NA): 888.988.ITAR
e Phone (Int'l): +1 650.318.4900
e Email: soc_tech_itar@microsemi.com

Regulatory and Compliance Information

EU Declaration of Conformity:

This product complies with Directive 2011/65/EU of the European Parliament and of the Council of 8 June 2011
on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

To view the Declaration of Conformity in English:
http://www.microsemi.com/index.php?option=com_docmané&task=doc download&gid=131772
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Non-English:
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=131748

Markings:

c € This product complies with 2004/108/EC, Electromagnetic Compatibility (EMC) Directive
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